Disaster Protection
This section covers:

Backing up and restoring data 

Fault tolerance 

Disaster recovery 
Backing Up and Restoring Data
Backup is a graphical program that you can use to back up and restore user data.

Before backing up data, see Checklists. 

For tips on backing up and restoring data, see Best practices. 

For help with specific tasks, see How to. 

For general background information, see Concepts. 

For problem-solving instructions, see Troubleshooting. 
Checklists

Checklist: Backing up data 

Checklist: Restoring data 
Checklist: Backing up data

Step
Reference

Review key concepts and prepare to back up data.
Concepts

Verify that you are logged on as a member of the Backup Operators group or Administrator group.
To add a user to the Backup Operators group

Verify that you can connect to all shared folders on other computers that need to be backed up. Note: you cannot back up another computer's registry, or other domain controllers.



If you are using an external storage device, verify that it is on the hardware compatibility list. Make sure it is cabled directly to the computer performing the backup and that the computer is turned on.
Hardware compatibility list, at the Microsoft Web site (http://www.microsoft.com/)

Insert the required tape into the tape drive. If backing up to a disk drive, verify there is enough available space.



If you are backing up to a media pool, verify Remote Storage is running.
To set up Remote Storage

If you are scheduling a backup operation, verify that Scheduled Tasks is running.
Using Scheduled Tasks

If you perform backup during working hours, ask users to close any files that you are going to back up or restore.



To back up files automatically, use the backup wizard.
To back up files with the backup wizard

To back up files manually, create a backup job from the Backup tab.
To back up files to a file or a tape

To back up files automatically, schedule a backup.
To schedule a backup
Checklist: Restoring data

Step
Reference

Verify that you are logged on as a member of the Backup Operators or Administrator groups.
To add a user to the Backup Operators group

Verify that you can connect to all shared folders on other computers that need to restored.



Insert the required tape into the tape drive.



If you are restoring from a media pool, verify that Remote Storage is running.
To set up Remote Storage

If you are restoring the System State, start the server in directory service restore mode.
To start Windows 2000 in safe mode, and click Directory Service Restore Mode

To restore files automatically, use the restore wizard.
To restore files with the restore wizard

To restore files manually, click the Restore tab to select files to restore.
To restore files from a file or a tape
Best Practices

Developing backup and restore strategies and testing them
A good plan ensures that you can quickly recover your data if it is lost. 

Training appropriate personnel
In minimum-security and medium-security networks, grant backup rights to one user and restore rights to a different user. Train personnel with restore rights to perform all of the restore tasks if the administrator is unavailable. 

In a high-security network, only administrators should restore files.

Backing up the whole volume
Back up an entire volume to prepare for the unlikely event of a disk failure. It is more efficient to restore the entire volume in one operation. 

Backing up directory services
Always back up the directory services database on a domain controller to prevent the loss of user account and security information. 

Creating a backup log
Always create and print a backup log for each backup. Keep a book of logs to make it easier to locate specific files. The backup log is helpful when restoring data; you can print it or read it from any text editor. Also, if the tape containing the backup set catalog is corrupted, the printed log can help you locate a file. 

Retaining copies
Keep three copies of the media. Keep at least one copy offsite in a properly controlled environment. 

Performing trial restorations
Perform a trial restoration periodically to verify that your files were properly backed up. A trial restoration can uncover hardware problems that do not show up with software verifications. 

Securing devices and media
Secure both the storage device and the backup media. It is possible for someone to access the data from a stolen medium by restoring the data to another server for which they are an administrator. 
How To...

Back up data 

Restore data 

Set Backup options 

Maintain media 

Add backup operators and set user rights 

Perform system repair and recovery 
Back up data

Back up files to a file or a tape 

Back up System State data 

Back up files with the backup wizard 

Schedule a backup 

Back up files on a Microsoft Exchange server 
To back up files to a file or a tape 
 1.
Open Backup. 
 2.
Click the Backup tab, and then on the Job menu, click New. 
 3.
Select the files and folders you want to back up by clicking the box to the left of a file or folder in Click to select the check box for any drive, folder, or file that you want to back up. 
 4.
In Backup destination, do one of the following: 

Choose File if you want to back up files and folders to a file. If you do not have a tape device installed on your computer, this is selected by default. 

Choose a tape device if you want to back up files and folders to a tape. 
 5.
In Backup media or file name, do one of the following: 

If you are backing up files and folders to a file, type a path and file name for the backup (.bkf) file, or click the Browse button to find a file. 

If you are backing up files and folders to a tape, choose the tape you want to use.
 6.
Select any backup options you want, such as the backup type and the log file type, by clicking the Tools menu, and then clicking Options. When you have finished selecting backup options, click OK. 
 7.
Click Start Backup, and then make any changes to the Backup Job Information dialog box. 
 8.
If you want to set advanced backup options such as data verification or hardware compression, click Advanced. When you have finished setting advanced backup options, click OK. 
 9.
Click Start Backup to start the backup operation. 
Important   You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000 it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to back up files and folders.  

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

You can also use the Backup wizard to back up files by clicking Backup Wizard on the Tools menu. 

If you are backing up files to a tape, and the Backup program indicates that there is no unused media available, you may have to use Removable Storage to add your tape to the Backup media pool. 

If you want to back up the System State data, which includes such things as the registry and the Active Directory directory service database, you must select System State in Click to select the check box for any drive, folder, or file that you want to back up. 

You can only back up the System State data on a local computer. You cannot back up the System State data on a remote computer. 

Backup files usually have the extension .bkf, although you can use any extension you like. 

Backup operators and administrators can back up and restore encrypted files and folders without decrypting the files or folders. 

If you have Windows Media Services running on your computer, and you want to back up the files associated with these services, see "Running Backup with Windows Media Services" in the Windows Media Services online documentation. You must follow the procedures outlined in the Windows Media Services online documentation before you can back up or restore files associated with Windows Media Services. 

If you are using Removable Storage to manage media, or you are using Remote Storage to store data, then you should regularly back up the files that are in the following folders: 

Systemroot\System32\Ntmsdata
Systemroot\System32\Remotestorage
This will ensure that all Removable Storage and Remote Storage data can be restored.
To back up System State data 
 1.
Open Backup. 
 2.
Click the Backup tab, and then in Click to select the check box for any drive, folder, or file that you want to back up click the box next to System State. This will back up the System State data along with any other data you have selected for the current backup operation. 
Notes

You must be an administrator or a backup operator to back up files and folders. 

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

You can also use the Backup wizard to back up the System State data by clicking Backup Wizard on the Tools menu. 

If you are backing up the System State data to a tape, and the Backup program indicates that there is no unused media available, you may have to use Removable Storage to add your tape to the Backup media pool so Backup can use it. 

You can only back up the System State data on a local computer. You cannot back up the System State data on a remote computer. 

When you back up the System State data, a copy of your registry files is also saved in the systemroot/repair/regback folder. If your registry files become corrupt or are accidentally erased, you can use these files to repair your registry without performing a full restore of the System State data. This method of repairing the registry is only recommended for advanced users. 
To back up files with the backup wizard 
 1.
Open Backup. 
 2.
On the Welcome tab, click Backup Wizard to start the backup wizard. 
Follow the wizard instructions to select what to back up, where to back up to, and which optional advanced backup features you want.
Notes

You must be an administrator or a backup operator to back up files and folders. 

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup.
To schedule a backup 
 1.
Open Backup. 
 2.
Click the Backup tab, and then on the Job menu, click New. 
 3.
Select the files and folders you want to back up by clicking the box to the left of a file or folder under Click to select the check box for any drive, folder or file that you want to back up. 
 4.
Select File or a tape device in Backup destination, and then save the file and folder selections by clicking the Job menu, and then clicking Save Selections. 
 5.
In Backup media or file name, type a path and file name for the backup file, or select a tape. 
 6.
Select any backup options you want, such as the backup type and the log file type, by clicking the Tools menu, and then clicking Options. When you have finished selecting backup options, click OK. 
 7.
Click Start Backup and make any changes you want to the Backup Job Information dialog box. 
 8.
If you want to set advanced backup options such as data verification or hardware compression, click Advanced. When you have finished selecting advanced backup options, click OK. 
 9.
Click Schedule in the Backup Job Information dialog box. 
10.
In the Set Account Information dialog box, enter the user name and password that you want the scheduled backup to run under. 
11.
In the Scheduled Job Options dialog box, in Job name, type a name for the scheduled backup job, and then click Properties to set the date, time, and frequency parameters for the scheduled backup. When you have finished, click OK, and then click OK again. 
Important   You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000, it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to back up files and folders. 

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

If you are scheduling a tape backup, you may have to use Removable Storage to make sure that your tape is available in the Backup media pool. 

You must have the Task Scheduler service running before you can schedule a backup. To do this, open the command prompt window and type net start schedule. You can also use Services in Computer Management to start, stop, and view the status of services. 

If you want to back up your System State data, which includes such things as the registry and Active Directory directory service, you must select System State in Click to select the check box for any drive, folder, or file that you want to back up. 

You can only back up the System State data on a local computer. You cannot back up the System State data on a remote computer. 

In the Scheduled Job Options dialog box, you can delete a scheduled backup from the Task Scheduler by clicking Delete. 

You can change the settings of a scheduled backup job after you schedule it by clicking the Schedule Jobs tab and then clicking the backup icon that is displayed on the calendar. 

Backup operators and administrators can back up and restore encrypted files and folders without decrypting the files or folders. 

If you have Windows Media Services running on your computer, and you want to back up the files associated with these services, see "Running Backup with Windows Media Services" in the Windows Media Services online documentation. You must follow the procedures outlined in the Windows Media Services online documentation before you can back up or restore files associated with Windows Media Services. 

If you are using Removable Storage to manage media, or you are using Remote Storage to store data, then you should regularly back up the files that are in the following folders: 

Systemroot\System32\Ntmsdata
Systemroot\System32\Remotestorage
This will ensure that all Removable and Remote Storage data can be restored.
To back up files on a Microsoft Exchange Server 
 1.
Open Backup. 
 2.
On the Backup tab, in Click to select the check box for any drive, folder, or file that you want to back up, click the box next to the Microsoft Exchange icon. 
 3.
In Server, type the name of the Microsoft Exchange Server that you want to back up. The name must begin with two backslashes (for example, \\London). 
 4.
Click Connect to Organization, and then click OK. 
Important   You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000 it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to back up files and folders.

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

This procedure and the accompanying notes are applicable to Microsoft Exchange version 5.5 and earlier. 

If you are backing up files to a tape, and the Backup program indicates that there is no unused media available, you may have to use Removable Storage to add your tape to the backup media pool.

When you restore data to a Microsoft Exchange Server, the Information Store service and Directory service are stopped. To start the services after the restore is complete, on the Tools menu, click Microsoft Exchange, click Start Service, select Directory or Information Store, and then click OK 
Restore data

Restore files from a file or a tape 

Restore System State data 

Restore files with the restore wizard 

Restore files to a Microsoft Exchange server 
To restore files from a file or a tape 
 1.
Open Backup. 
 2.
On the Restore tab, in Click to select the check box for any drive, folder, or file that you want to restore, select the files and folders you want to restore by clicking the box to the left of a file or folder. 
 3.
In Restore files to, do one of the following: 

Click Original location if you want the backed up files and folders to be restored to the folder or folders they were in when they were backed up. Skip to step 5. 

Click Alternate location if you want the backed up files and folders to be restored to a folder that you designate. This option will preserve the folder structure of the backed up data; all folders and subfolders will appear in the alternate folder you designate. 

Click Single folder if you want the backed up files and folders to be restored to a folder that you designate. This option will not preserve the folder structure of the backed up data; the files will appear only in the folder that you designate. 
 4.
If you selected Alternate location or Single folder, type a path for the folder under Alternate location, or click the Browse button to find the folder. 
 5.
On the Tools menu, click Options, click the Restore tab, and then do one of the following: 

Click Do not replace the file on my computer if you do not want the restore operation to copy over files that are already on your hard disk. 

Click Replace the file on disk only if the file on disk is older if you want the restore operation to replace older files on your disk with newer files from your backup. 

Click Always replace the file on my computer if you want the restore operation to replace files on your disk regardless of whether the backup files are newer or older. 

Click OK to accept the restore options you have set.
 6.
Click Start Restore. 
 7.
If you want to change any of the advanced restore options, such as restoring security settings, the Removable Storage database, and junction point data, click Advanced. When you are done setting advanced restore options click OK. 
 8.
Click OK to start the restore operation. 
Caution

If you are restoring the System State data, and you do not designate an alternate location for the restored data, Backup will erase the System State data that is currently on your computer and replace it with the System State data you are restoring. Also, if you restore the System State data to an alternate location, only the registry files, SYSVOL directory files, Cluster database information files, and system boot files are restored to the alternate location. The Active Directory directory services database, Certificate Services database and COM+ Class Registration database are not restored if you designate an alternate location. 

Choosing Replace the file on disk only if the file on disk is older could change some or all of the files that are currently on your disk. 

Choosing Always replace the file on my computer could cause you to lose data if a file you are working on is contained in the backup. 

You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000 it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to restore files and folders.

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

If you are restoring data from a tape, you should update the on-disk catalog for the tape before you perform the restore operation.

You can also use the Restore wizard to restore files by clicking Restore Wizard on the Tools menu. 

In order to restore the System State data on a domain controller, you must first start your computer in Directory Services Restore Mode. This will allow you to restore the SYSVOL directory and the Active Directory directory service database. 

You can only restore the System State data on a local computer. You cannot restore the System State data on a remote computer. 

Backup operators and administrators can back up and restore encrypted files and folders without decrypting the files or folders. 
To restore System State data 
 1.
Open Backup. 
 2.
Click the Restore tab, and then in Click to select the check box for any drive, folder, or file that you want to restore, click the box next to System State. This will restore the System State data along with any other data you have selected for the current restore operation. 
Caution   If you restore the System State data, and you do not designate an alternate location for the restored data, Backup will erase the System State data that is currently on your computer and replace it with the System State data you are restoring. Also, if you restore the System State data to an alternate location, only the registry files, SYSVOL directory files, Cluster database information files, and system boot files are restored to the alternate location. The Active Directory directory services database, Certificate Services database, and COM+ Class Registration database are not restored if you designate an alternate location. 
Notes

You must be an administrator or a backup operator to restore files and folders.

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

If you are restoring data from a tape, you should update the on-disk catalog for the tape before you perform the restore operation. 

You can also use the Restore wizard to restore the System State data by clicking Restore Wizard on the Tools menu. 

If you are restoring the System State data to a domain controller, you must choose whether you want to perform an authoritative restore or a nonauthoritative restore. The default method of restoring the System State data to a domain controller is nonauthoritative. In this mode, any component of the System State that is replicated with another domain controller, such as the Active Directory directory service or the File Replication service (including the SYSVOL directory), will be brought up to date by replication after you restore the data. For example, if the last backup was performed a week ago, and the System State is restored using the default restore method (nonauthoritative), any changes made subsequent to the backup operation will be replicated from the domain controllers. 

In some cases, you may not want to replicate the changes that have been made subsequent to the last backup operation. In other words, there may be instances where you want all replicas to have the same state as the backed up data. To achieve this state, you must perform an authoritative restore.

For example, you have to perform an authoritative restore if you inadvertently delete users, groups, or organizational units from the Active Directory directory service, and you want to restore the system so that the deleted objects are recovered and replicated. To do this, you need to run the Ntdsutil utility after you have restored the data but before you restart the domain controller. This utility lets you mark objects as authoritative, which will ensure that any replicated or distributed data that you have restored is properly replicated or distributed throughout your organization. The Ntdsutil command line utility can be run from the command prompt. Help for the Ntdsutil utility can also be found at the command prompt by typing ntdsutil /?.

In order to restore the System State data on a domain controller, you must first start your computer in a special safe mode called directory services restore mode. This will allow you to restore the SYSVOL directory and Active Directory directory service database. 

You can only restore the System State data on a local computer. You cannot restore the System State data on a remote computer. 
To restore files with the restore wizard 
 1.
Open Backup. 
 2.
On the Welcome tab, click Restore Wizard to start the restore wizard. 
 3.
Follow the wizard instructions to select what to restore, where to restore to, and which optional advanced restore features you want. 
Notes

You must be an administrator or a backup operator to restore files and folders.

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup.
To restore files to a Microsoft Exchange Server 
 1.
Open Backup. 
 2.
On the Restore tab, in Click to select the check box for any drive, folder, or file that you want to restore, select the Microsoft Exchange data you want to restore. Click Start Restore. 

The Restoring Microsoft Exchange dialog box will appear.
 3.
If you are restoring Information Store data, type the name of the server to which you are restoring data in Restore to. 

Note   If you designate a server that is different from the original server the data was backed up from, you must also choose Erase all existing data.
 4.
Choose any other options you want, and then click OK. 
Important   You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000 it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to restore files and folders. 

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

If you are restoring data from a tape, you should update the on-disk catalog for the tape before you perform the restore operation. 

This procedure and the accompanying notes are applicable to Microsoft Exchange version 5.5 and earlier. 

When you restore data to a Microsoft Exchange Server, the Information Store service and Directory service are stopped. To start the services after the restore is complete, on the Tools menu, click Microsoft Exchange, click Start Service, select Directory or Information Store, and then click OK. 
Set Backup options

Set backup options 

Set the backup type 

Exclude file types from a backup 

Set advanced backup options 

Set restore options 

Set advanced restore options 
To set backup options 
 1.
Open Backup. 
 2.
On the Tools menu click Options. 
 3.
On the General tab, set the options you want. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

Choosing Compute selection information before backup and restore operations estimates the number of files and bytes that will be backed up or restored during the current backup or restore operation. This information will be calculated and displayed before the backup or restore begins. 

Choosing Use the catalogs on the media to speed up building restore catalogs on disk indicates that you want to use the on-media catalog to build the on-disk catalog for restore selections. This is the fastest way to build an on-disk catalog. However, if you want to restore data from several tapes, and the tape with the on-media catalog is missing, or you want to restore data from media that is damaged, you should not select this option. Backup will then scan your entire backup set (or as much of it as you have), and build an on-disk catalog. This could take several hours if your backup set is very large. 

Choosing Verify data after the backup completes checks the backed-up data and the original data on your hard disk to be sure that the data is the same. If it is not, there may be a problem with the media or the file you are using to back up data. If this occurs, you should use different media or designate another file, and you should run the backup operation again. 

Choosing Back up the contents of mounted drives backs up the data that is on a mounted drive. If you select this option, and you back up a mounted drive, the data that is on the mounted drive will be backed up. If you do not select this option, and you back up a mounted drive, only the path information for the mounted drive will be backed up. 

Choosing Show alert message when I start Backup and Removable Storage is not running displays a dialog box when you start Backup and Removable Storage is not running. If you primarily back up data to a file, and you save the file to a floppy disk, a hard disk, or any type of removable disk, you do not need to check this box. If you primarily back up data to a tape, or other media that is managed by Removable Storage, you should check this box. 

Choosing Show alert message when I start Backup and there is compatible import media available displays a dialog box when you start Backup and there is new media available in the Import media pool. If you primarily back up data to a file, and you save the file to a floppy disk, a hard disk, or any type of removable disk, you do not need to check this box. If you primarily back up data to a tape, or other media that is managed by Removable Storage, you should check this box.

Choosing Show alert message when new media is inserted into Removable Storage displays a dialog box when new media is detected by Removable Storage. If you primarily back up data to a file, and you save the file to a floppy disk, a hard disk, or any type of removable disk, you do not need to check this box. If you primarily back up data to a tape, or other media that is managed by Removable Storage, you should check this box. 

Choosing Always move new import media to Backup pools automatically moves new media that is detected by Removable Storage to the Backup media pool. If you primarily back up data to a file, and you save the file to a floppy disk, a hard disk, or any type of removable disk, you do not need to check this box. If you use Removable Storage to manage your media, and you want all new media to be available to the Backup program only, you should check this box. 
To set the backup type 
 1.
Open Backup. 
 2.
On the Tools menu, click Options. 
 3.
On the Backup Type tab, in Default Backup Type, select the type of backup you want to perform. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

There are five backup types: copy, daily, differential, incremental, and normal. 
To exclude file types from a backup 
 1.
Open Backup. 
 2.
On the Tools menu, click Options. 
 3.
On the Exclude Files tab, do one of the following: 

Click Add new under the Files excluded for all users list if you want to exclude files that are owned by all users. 

Click Add new under the Files excluded for user list if you want to exclude only files that you own. 
 4.
In the Add Excluded Files dialog box, do one of the following: 

If you want to exclude a registered file type, click the file type in Registered file type. 

If you want to exclude a custom file type, enter a period and then the one, two, or three letter file extension in Custom file mask. 
 5.
Type a path in Applies to path if you want to restrict the excluded file type to a specific folder or hard disk drive, and then click OK. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

If you restrict excluded files to a specific path (folder), the files will be restricted from all subfolders of that path unless you clear the Applies to all subfolders check box. 

You can change how a file is excluded from a backup set by clicking the file in Files excluded for all users or Files excluded for user, and then clicking Edit. The Add Excluded Files dialog box should appear. 
To set advanced backup options 
 1.
Open Backup. 
 2.
Click the Backup tab and select the files and folders you want to back up. 
 3.
Click Start Backup. 
 4.
On the Backup Job Information dialog box, click Advanced. 
 5.
Set the advanced backup options you want, and then click OK. See the Notes section for a description of each option. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

Choosing Back up data that is in Remote Storage backs up data that has been designated for Remote Storage. If you select this option, Remote Storage placeholder files are backed up. If you do not select this option, Remote Storage placeholder files are not backed up. You can restore Remote Storage data only to an NTFS volume that is used in Windows 2000. 

Choosing Verify data after backup verifies that the backed-up data is exactly the same as the original data. This could substantially increase the time it takes to perform a backup. 

Choosing If possible, compress the backup data to save space compresses the data you are backing up so you can save more data on a tape. Usually, only tape drives have the ability to compress data. If this option is disabled, you do not have a tape drive on your computer or your tape drive cannot compress data. 

Choosing Automatically back up system protected files with the System State backs up all of the system files that are in your systemroot directory in addition to the boot files that are included with the System State data. This option will substantially increase the size of your backup job. For example, if you choose this option on Windows 2000 Professional, it will add over 200 megabytes to the size of your backup job. 

Choosing a backup type in Backup Type determines how your data is backed up. Backup types include: copy, daily, differential, incremental, and normal. 
To set restore options 
 1.
Open Backup. 
 2.
On the Tools menu, click Options. 
 3.
On the Restore tab, do one of the following: 

Click Do not replace the file on my computer if you do not want the restore operation to copy over files that are already on your disk. 

Click Replace the file on disk only if the file on disk is older if you want the restore operation to replace older files on your disk with newer files from your backup. 

Click Always replace the file on my computer if you want the restore operation to replace files on your disk regardless whether the backup files are newer or older. 
Important

Choosing Replace the file on disk only if the file on disk is older could change some or all of the files that are currently on your disk. 

Choosing Always replace the file on my computer could cause you to lose data if a file you are working on is contained in the backup. 
Note   To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup.
To set advanced restore options 
 1.
Open Backup. 
 2.
Click the Restore tab and select the files and folders you want to restore. 
 3.
Click Start Restore. 
 4.
On the Confirm Restore dialog box, click Advanced. 
 5.
Set the advanced restore options you want, and then click OK. See the Notes section for a description of each option. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

Choosing Restore security will restore security settings for each file and folder. Security settings include permissions, audit entries, and ownership. This option is available only if you have backed up data from an NTFS volume used in Windows 2000 and you are restoring it to an NTFS volume used in Windows 2000. 

Choosing Restore Removable Storage database will restore the Removable Storage database, which is stored in Systemroot\System32\Ntmsdata. If you are not using Removable Storage to manage storage media, you do not need to select this option. Also, this will delete your existing Removable Storage database. 

Choosing Restore junction points, and restore file and folder data under junction points to the original location restores junction points on your hard disk as well as the data that the junction points point to. If you do not select this check box, the junction points will be restored but the data your junction points point to may not be accessible. Also, if you are restoring a mounted drive, and you want to restore the data that is on the mounted drive, you must select this check box. If you do not select this check box, you will only restore the folder containing the mounted drive. 

Choosing When restoring replicated data sets, mark the restored data as the primary data for all replicas ensures that restored File Replication service (FRS) data is replicated to your other servers. If you are restoring FRS data, you should choose this option. If you do not choose this option, the FRS data that you are restoring may not be replicated to other servers because the restored data will appear to be older than the data already on the servers. This will cause the other servers to overwrite the restored data, thereby preventing you from restoring the FRS data. 

Choosing Preserve existing volume mount points will prevent the restore operation from writing over any volume mount points you have created on the partition or volume you are restoring data to. This option is primarily applicable when you are restoring data to an entire drive or partition. For example, if you are restoring data to a replacement drive, and you have partitioned and formatted the drive and restored volume mount points, you should select this option so your volume mount points are not restored. If you are restoring data to a partition or drive that you have just reformatted, and you want to restore the old volume mount points, you should not select this option. 
Maintain media

Format a tape 

Retension a tape 

Erase a tape 

Delete a catalog 

Update a catalog 
To format a tape 
 1.
Open Backup. 
 2.
On the Restore tab, right-click the tape you want to format. 
 3.
Click Format. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

This procedure is only applicable if you have a DC-2000-type tape drive, which requires that you format a tape before you use it. 
To retension a tape 
 1.
Open Backup. 
 2.
On the Restore tab, click the tape you want to retension. 
 3.
On the Tools menu, click Media Tools, and then click Retension. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

You can also access the Retension command by right-clicking a tape on the Restore tab. 
To erase a tape 
 1.
Open Backup. 
 2.
On the Restore tab, click the tape you want to erase. 
 3.
On the Tools menu, click Media Tools, and then click Erase. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

You can only erase a tape if it is in the tape drive or in a loader slot of a tape change. 

Erasing a tape moves the tape from the backup media pool to the free media pool. 

You can also use Removable Storage to erase a tape. 

You can also access the Erase command by right-clicking a tape on the Restore tab. 
To delete a catalog 
 1.
Open Backup. 
 2.
On the Restore tab, right-click the backup set that contains the catalog you want to delete. 
 3.
Click Delete catalog if the backup set has been saved to a file, or click Delete from system if the backup set has been saved to a tape. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

This procedure should only be used if you have a damaged or lost tape or file, and you want to delete it from the on-disk catalog. 

If you are deleting a catalog for a tape, this procedure will only work if the tape is not in the tape drive or it is not in a tape loader slot. 

If you click Delete catalog, this procedure will delete the on-disk catalog for the selected backup set. It will not delete the backup file. 

If you click Delete from system, this procedure will delete the on-disk catalog for the selected backup set and it will delete the tape from the Removable Storage database. It will not delete the on-media catalog that is on the tape. 

You can restore a catalog for a file or a tape by clicking the Restore tab, right-clicking File or the tape you want to catalog, and then clicking Catalog file or Catalog.
To update a catalog 
 1.
Open Backup. 
 2.
On the Restore tab, right-click the media containing the backup set you want to catalog. 
 3.
Click Catalog. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

This procedure creates an on-disk catalog. It does not create an on-media catalog. 

If you are creating a catalog of a backup set that is saved on a tape, you should do one of the following before you perform this procedure: 

If you have all of the tapes in the backup set, and the tapes are not damaged or corrupted, click the Tools menu, click Options, click the General tab, and then make sure the Use the catalogs on the media to speed up building restore catalogs on disk check box is checked. This will speed up the cataloging process. 

If you are missing a tape in the backup set, or a tape is damaged or corrupted, click the Tools menu, click Options, click the General tab, and then make sure the Use the catalogs on the media to speed up building restore catalogs on disk check box is cleared. This will ensure that the catalog is complete and accurate; however, it could take a long time to create the catalog. 
Add backup operators and set user rights

Add a user to the Backup Operators group 

Add a user to the Backup Operators group on a domain controller 
To add a user to the Backup Operators group 
 1.
Open Computer Management. 
 2.
In the console tree, click Local Users and Groups. 
 3.
In the details pane double-click Groups, and then double-click Backup Operators. 
 4.
On the Backup Operators Properties dialog box, click Add. 
 5.
On the Select Users or Groups dialog box, next to Name, type the domain and user name of the person you want to make a backup operator. Type the domain name first, then a backslash, then the user name. For example, \\London\William. 
 6.
Click Add, and then click OK. 
Important   To add a user to the Operators Group on a domain controller you must use Active Directory Users and Computers. 
Notes

You must be a member of the Administrators group to designate users as Backup Operators. 

To open Computer Management, click Start, point to Settings, and click Control Panel. In the Control Panel dialog box, double-click Administrative Tools and then double-click Computer Management. 
To add a user to the Backup Operators group on a domain controller
 1.
OpenActive Directory Users and Computers. 
 2.
In the console tree, double-click the domain node. 
 3.
In the details pane, double-click the Builtin folder, right-click Backup Operators, and then click Properties. 
 4.
Click the Members tab, and then double-click the group you want to add a member to. 
 5.
On the Member Of tab, select the name of the member you want to add to the group, and then click Add. 
 6.
At the top of the pane, click the Look in arrow to display a list of domains from which users and computers can be added to the group, and then click the domain containing the users and computers you want to add. 
 7.
Click the users to be added, click Add, and then click OK. 
Note   To open Active Directory Users and Computers, click Start, point to Programs, point to Administrative Tools, and then click Active Directory Users and Computers.
Perform system repair and recovery

Install the Recovery Console as a startup option 

Delete the Recovery Console 

Run the Recovery Console on a system that will not start 

Create an Emergency Repair Disk 
To install the Recovery Console as a startup option
 1.
With Windows running, insert the Windows 2000 Professional CD into your CD-ROM drive. 
 2.
Click No when prompted to upgrade to Windows 2000. 
 3.
At the command prompt, switch to your CD-ROM drive, and then type the following: 

\i386\winnt32.exe /cmdcons
 4.
Follow the instructions on the screen. 
Notes

To run the Recovery Console, you must restart your computer and select the Recovery Console option from the list of available operating systems. 

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To see the commands available on the Recovery Console, type help at the command prompt. 

You can allow a user to run the Recovery Console without logging on by enabling the Automatic administrative logon when using recovery console attribute in the Group Policy snap-in. This attribute is located in the console tree under Local Computer Policy/Computer Configuration/Windows Settings/Security Settings/Local Policies/Security Options. 

If your computer will not start, you can run the Recovery Console from the Windows 2000 Professional CD (if you have a bootable CD-ROM drive) or the Setup disks. 
To delete the Recovery Console 
 1.
Restart your computer. 
 2.
Double-click My Computer, and then double-click the hard drive on which you installed the Recovery Console. 
 3.
On the Tools menu, click Folder Options. 
 4.
Click the View tab. 
 5.
Click Show hidden files and folders, clear the Hide protected operating system files check box, and then click OK. 
 6.
At the root directory, delete the \Cmdcons folder. 
 7.
At the root directory, delete the file Cmldr. 
 8.
At the root directory, right-click the Boot.ini file and then click Properties. 
 9.
Clear the Read-only check box, and then click OK. 
10.
Open Boot.ini in Notepad, and remove the entry for the Recovery Console. It will look similar to this: 

C:\cmdcons\bootsect.dat="Microsoft Windows 2000 Recovery Console" /cmdcons
11.
Save the file and close it. 
Warning   Modifying the Boot.ini file incorrectly may prevent your computer from restarting. Be sure to delete only the entry for the Recovery Console. 
Notes   It is recommended that you change the attribute for the Boot.ini file back to read-only after you complete this procedure. You may also want to hide your system files again. 
To run the Recovery Console on a system that will not start 
 1.
Insert the Windows 2000 Professional Setup Disk 1 (3.5-inch) into your disk drive or, if you have a bootable CD-ROM drive, insert the Windows 2000 Professional CD into your CD-ROM drive. 
 2.
Restart your computer. 
 3.
Follow the directions on the screen. If you are using the Setup disks, you will be prompted to insert the other Setup disks into the disk drive. It may take several minutes to load files. Choose the options to repair your Windows 2000 installation, and finally to start the Recovery Console. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To see the commands available on the Recovery Console, type help at the command prompt. 

As an alternative, you can install the Recovery Console on your computer so it is always available. 
To create an Emergency Repair Disk 
 1.
Open Backup. 
 2.
On the Tools menu, click Create an Emergency Repair Disk. 
 3.
Follow the instructions that appear on your screen. 
Important

You will need a blank 1.44 MB floppy disk to create an Emergency Repair Disk (ERD). 

The repair process relies on information that is saved in the systemroot\repair folder. You must not change or delete this folder. 
Notes

To start Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 

Choosing Also back up the registry to the repair directory will save your current registry files in a folder within your systemroot/repair folder. This is useful if you need to recover your system in the event your hard disk has failed. 

Additional information on the repair process is available. If you are using Windows 2000 Professional, see the Windows 2000 Professional Getting Started online book or the Windows 2000 Professional Getting Started book that came with your Windows 2000 CD. If you are using Windows 2000 Server, see the Disaster Recovery How to section. 
Concepts
This section provides general background information about the backup and restore capabilities of Windows 2000:

Backup overview 

Understanding Backup 

Using Backup 

Resources 
Backup overview
The Backup utility helps you protect data from accidental loss if your system experiences hardware or storage media failure. For example, you can use Backup to create a duplicate copy of the data on your hard disk and then archive the data on another storage device such as a hard disk or a tape. If the original data on your hard disk is accidentally erased or overwritten, or becomes inaccessible because of a hard disk malfunction, you can easily restore the data from the archived copy.
Using Backup, you can: 

Archive selected files and folders on your hard disk. 

Restore the archived files and folders to your hard disk or any other disk you can access. 

Create an Emergency Repair Disk (ERD), which helps you repair system files if they get corrupted or are accidentally erased. 

Make a copy of any Remote Storage data and any data stored in mounted drives. 

Make a copy of your computer's System State, which includes the registry, the Active Directory database, and the Certificate Services database. 

Schedule regular backups to keep your archived data up-to-date. 
You can use Backup to back up and restore data on either file allocation table (FAT) or NTFS file system volumes. However, if you have backed up data from an NTFS volume used in Windows 2000, it is recommended that you restore the data to an NTFS volume used in Windows 2000. If you do not, you could lose data as well as some file and folder features such as permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information. 
For a list of Backup enhancements, see New features.
New features
You can now use the Backup utility to back up files to a wide variety of storage devices in addition to a tape drive. The backup medium can be a logical drive, a removable disk, recordable CD-ROMs, or an entire library of disks or tapes organized into a media pool and controlled by a robotic changer. If you do not have a separate storage device, you can back up to another hard disk or to a floppy disk.
In addition, Backup no longer manages the storage devices and media. Tasks such as mounting and dismounting a tape or disk are now done by a service called Removable Storage, which is an integral part of Windows 2000.
Other enhancements to Backup include:

Full user interface with backup and restore wizards, property sheets for media pools, and direct access to My Network Places. 

Full support for backing up and restoring Windows 2000 System State, which includes the system files, the registry, Component Services, the Active Directory database, file replication service, and the Certificate Services database. 

Integration with Windows 2000 Task Scheduler for automating backup jobs. 

Integration with Remote Storage for archiving data. 
Understanding Backup
This section covers:

Types of backup 

Permissions and user rights 

System State data 

Authoritative restore 

Repair overview 

Recovery Console overview 
Types of backup
The Backup utility supports five methods of backing up data on your computer or network. 
Copy backup
A copy backup copies all selected files but does not mark each file as having been backed up (in other words, the archive attribute is not cleared). Copying is useful if you want to back up files between normal and incremental backups because copying does not affect these other backup operations. 
Daily backup
A daily backup copies all selected files that have been modified the day the daily backup is performed. The backed-up files are not marked as having been backed up (in other words, the archive attribute is not cleared). 
Differential backup
A differential backup copies files created or changed since the last normal or incremental backup. It does not mark files as having been backed up (in other words, the archive attribute is not cleared). If you are performing a combination of normal and differential backups, restoring files and folders requires that you have the last normal as well as the last differential backup. 
Incremental backup
An incremental backup backs up only those files created or changed since the last normal or incremental backup. It marks files as having been backed up (in other words, the archive attribute is cleared). If you use a combination of normal and incremental backups, you will need to have the last normal backup set as well as all incremental backup sets in order to restore your data. 
Normal backup
A normal backup copies all selected files and marks each file as having been backed up (in other words, the archive attribute is cleared). With normal backups, you need only the most recent copy of the backup file or tape to restore all of the files. You usually perform a normal backup the first time you create a backup set. 
Backing up your data using a combination of normal backups and incremental backups requires the least amount of storage space and is the quickest backup method. However, recovering files can be time-consuming and difficult because the backup set can be stored on several disks or tapes.
Backing up your data using a combination of normal backups and differential backups is more time-consuming, especially if your data changes frequently, but it is easier to restore the data because the backup set is usually stored on only a few disks or tapes. 
Permissions and user rights
You must have certain permissions or user rights to back up files and folders. If you are an administrator or a backup operator in a local group, you can back up any file and folder on the local computer to which the local group applies. Likewise, if you are an administrator or backup operator on a domain controller you can back up any file and folder on any computer in the domain or any computer on a domain with which you have a two-way trust relationship (except System State data; see note below). However, if you are not an administrator or a backup operator, and you want to back up files, then you must be the owner of the files and folders you want to back up, or you must have one or more of the following permissions for the files and folders you want to back up: Read, Read and execute, Modify, or Full Control. 
You must also be certain that there are no disk quota restrictions that may restrict your access to a hard disk, thereby making it impossible for you to back up data. You can check whether you have any disk quota restrictions by right-clicking the disk you want to save data to, clicking Properties, and then clicking the Quota tab. 
You can also restrict access to a backup file by selecting Allow only the owner and the Administrator access to the backup data in the Backup Job Information dialog box. If you select this option, only an administrator or the person who created the backup file will be able to restore the files and folders. 
Note   You can only back up System State data on a local computer. You can't back up System State data on a remote computer even if you are an administrator or a backup operator on the remote computer. 
System State data
You can back up and restore the following system components using Backup:

Registry 

COM+ Class Registration database 

Boot files, including the system files 

Certificate Services database 

Active Directory directory service 

SYSVOL directory 

Cluster service information 
Backup refers to these system components as the System State data. For Windows 2000 Professional, the System State data comprises only the registry, COM+ Class Registration database, and boot files. For Windows 2000 Server operating systems, the System State data comprises the registry, COM+ Class Registration database, system boot files, and the Certificate Services database (if the server is a certificate server). If the server is a domain controller, Active Directory and the SYSVOL directory are also contained in the System State data. Also, if you are running the domain name service (DNS) on a domain controller, then the Active Directory portion of the System State data also contains all of the DNS zone information (DS integrated and non-DS integrated). Finally, if the server is running the Cluster service, then the System State data will also include any resource registry checkpoints and the quorum resource recovery log, which contains the most recent cluster database information.
When you choose to back up or restore the System State data, all of the System State data that is relevant to your computer is backed up or restored; you cannot choose to back up or restore individual components of the System State data. This is due to dependencies among the System State components. However, you can restore the System State data to an alternate location. If you do this, only the registry files, SYSVOL directory files, Cluster database information files, and system boot files are restored to the alternate location. The Active Directory directory services database, Certificate Services database, and COM+ Class Registration database are not restored if you designate an alternate location when you restore the System State data.
Furthermore, if you have more than one domain controller in your organization, and the Active Directory directory service is replicated to any of these other servers, you may have to authoritatively restore any Active Directory data that you want to restore. To do this, you need to run the Ntdsutil utility after you have restored the System State data but before you restart the server on the network. The Ntdsutil utility lets you mark Active Directory objects for authoritative restore. This will ensure that any replicated or distributed data that you restore is properly replicated or distributed throughout your organization.
For example, if you inadvertently delete or modify objects stored in the Active Directory directory service, and those objects are replicated or distributed to other servers, you will need to authoritatively restore those objects so they are replicated or distributed to the other servers. If you do not authoritatively restore the objects, they will never get replicated or distributed to your other servers because they will appear to be older than the objects currently on your other servers. Using the Ntdsutil utility to mark objects for authoritative restore ensures that the data you want to restore gets replicated or distributed throughout your organization. On the other hand, if your system disk has failed or the Active Directory database is corrupted, then you can simply restore the data nonauthoritatively without using the Ntdsutil utility.
The Ntdsutil command line utility can be run from the command prompt. Help for the Ntdsutil utility can also be found at the command prompt by typing ntdsutil /?.
Notes

You must have certain permissions or user rights to back up files and folders. 

In order to restore the System State data on a domain controller, you must first start your computer in directory services restore mode. This will allow you to restore the SYSVOL directory and the Active Directory. 

You can only back up and restore the System State data on a local computer. You cannot back up and restore the System State data on a remote computer. 

Although you can't change which components of the System State are backed up, you can back up all of the protected system files with the System State data by setting advanced backup options. 
Authoritative restore
In Backup, distributed services such as the Active Directory directory service are contained in a collection known as the System State data. When you back up the System State data on a domain controller, you are backing up all Active Directory data that exists on that server (along with other system components such as the SYSVOL directory and the registry). In order to restore these distributed services to that server, you must restore the System State data. However, if you have more than one domain controller in your organization, and your Active Directory is replicated to any of these other servers, you will need to perform what is called an authoritative restore in order to ensure that your restored data gets replicated to all of your servers. 
During a normal restore operation, Backup operates in nonauthoritative restore mode. That is, any data that you restore, including Active Directory objects, will have their original update sequence number. The Active Directory replication system uses this number to detect and propagate Active Directory changes among the servers in your organization. Because of this, any data that is restored nonauthoritatively will appear to the Active Directory replication system as though it is old, which means the data will never get replicated to your other servers. Instead, the Active Directory replication system will actually update the restored data with newer data from your other servers. Authoritative restore solves this problem. 
To authoritatively restore Active Directory data, you need to run the Ntdsutil utility after you have restored the System State data but before you restart the server. The Ntdsutil utility lets you mark Active Directory objects for authoritative restore. When an object is marked for authoritative restore its update sequence number is changed so that it is higher than any other update sequence number in the Active Directory replication system. This will ensure that any replicated or distributed data that you restore is properly replicated or distributed throughout your organization.
For example, if you inadvertently delete or modify objects stored in the Active Directory directory service, and those objects are replicated or distributed to other servers, you will need to authoritatively restore those objects so they are replicated or distributed to the other servers. If you do not authoritatively restore the objects, they will never get replicated or distributed to your other servers because they will appear to be older than the objects currently on your other servers. Using the Ntdsutil utility to mark objects for authoritative restore ensures that the data you want to restore gets replicated or distributed throughout your organization. On the other hand, if your system disk has failed or the Active Directory database is corrupted, then you can simply restore the data nonauthoritatively without using the Ntdsutil utility.
The Ntdsutil command line utility can be run from the command prompt. Help for the Ntdsutil utility can also be found at the command prompt by typing ntdsutil /?.
Caution   When you restore the System State data, and you do not designate an alternate location for the data, Backup will erase the System State data that is currently on your computer and replace it with the System State data you are restoring. 
Notes

You must be an administrator or a backup operator to back up files and folders. 

In order to restore the System State data on a domain controller, you must first start your computer in directory services restore mode. This will allow you to restore the SYSVOL directory and the Active Directory.

You can only restore the System State data on a local computer. You cannot restore the System State data on a remote computer. 
Repair overview
Windows 2000 has several features that allow you to repair a system that will not start or will not load Windows 2000. These features are useful if some of your system files become corrupted or are accidentally erased, or if you have installed software or device drivers that cause your system to not work properly. 
Safe mode
Safe mode lets you start your system with a minimal set of device drivers and services. For example, if newly installed device drivers or software are preventing your computer from starting, you may be able to start you computer in safe mode and then remove the software or device drivers from your system. Safe mode will not work in all circumstances, especially if your system files are corrupted or missing or your hard disk is damaged or has failed. For information about the safe mode options, see Safe mode startup options.
Windows 2000 Recovery Console
The Recovery Console feature provides you with a command-line interface that will let you repair system problems using a limited set of command-line commands. For example, you could use the Recovery Console to enable and disable services, repair a corrupted master boot record, or copy system files from a floppy disk or a CD-ROM. This feature gives you maximum control over the repair process and should be used only by advanced users and administrators. 
Emergency Repair Process
The Emergency Repair Disk (ERD) feature helps you repair problems with system files, your startup environment (if you have a dual-boot or multiple-boot system), and the partition boot sector on your boot volume. Before you use the Emergency Repair Disk feature to repair your system you must create an Emergency Repair Disk. You can do this using the Backup utility. Even if you have not created an Emergency Repair Disk you can still try to use the Emergency Repair Disk process; however, any changes you have made to your system, such as Service Pack updates, may be lost and may need to be reinstalled. 
You can also reinstall Windows 2000 over a damaged Windows 2000 system. This may be time-consuming, but is useful if the emergency repair process does not solve your problem. If you reinstall your system you may lose changes that have been made to your system, such as Service Pack upgrades, and you will need to reinstall those upgrades.
Recovery Console overview
The Windows 2000 Recovery Console is a command-line console that you can start from the Windows 2000 Setup program. Using the Recovery Console, you can start and stop services, format drives, read and write data on a local drive (including drives formatted to use NTFS), and perform many other administrative tasks. The Recovery Console is particularly useful if you need to repair your system by copying a file from a floppy disk or CD-ROM to your hard drive, or if you need to reconfigure a service that is preventing your computer from starting properly. Because the Recovery Console is quite powerful, it should only be used by advanced users who have a thorough knowledge of Windows 2000. In addition, you must be an administrator to use the Recovery Console.
There are two ways to start the Recovery Console:

If you are unable to start your computer, you can run the Recovery Console from your Windows 2000 Setup disks or from the Windows 2000 Professional CD (if you can start your computer from your CD-ROM drive). 

As an alternative, you can install the Recovery Console on your computer to make it available in case you are unable to restart Windows 2000. You can then select the Recovery Console option from the list of available operating systems.
After you start the Recovery Console you will have to choose which drive you want to log on to (if you have a dual-boot or multiple-boot system) and you will have to log on with your administrator password.
In addition, if you are using Windows 2000 Professional, see the Windows 2000 Professional Getting Started online book, or the Windows 2000 Professional Getting Started book that came with your Windows 2000 CD. If you are using Windows 2000 Server, see the Disaster Recovery How to section.
Once you are running the Recovery Console, you can get help on the available commands by typing help at the command prompt.
Using Backup
This section covers:

Backing up files and folders 

Using batch files to back up data 

Command line examples 

Command line parameters 

Restoring files and folders 

Restoring a domain controller 

Recovery Console commands 
Backing up files and folders
Backup lets you back up data to a file or to a tape. When you back up data to a file, you have to designate a file name and a location for the file to be saved. Backup files usually have the extension .bkf, but you can change it to any extension you prefer. A backup file can be saved to a hard disk, a floppy disk, or to any other removable or nonremovable media on which you can save a file.
When you back up data to a tape, you must have a tape device connected to your computer. Also, tapes are managed by Removable Storage. Although Backup works together with Removable Storage, you may have to use Removable Storage to perform certain maintenance tasks, such as preparing and ejecting tapes.
The following four steps describe a simple backup operation:
Select files, folders, and drives for backup
Backup provides you with a tree view of the drives, files, and folders that are on your computer, which you can use to select the files and folders that you want to back up. You can use this tree view the same way you use Windows Explorer to open drives and folders and select files.
Select storage media or file location for backed-up data
Backup provides two options for selecting storage media: 
You can back up your data to a file on a storage device. A storage device can be a hard disk, a Zip disk, or any type of removable or nonremovable media to which you can save a file. This option is always available.
You can back up your data to a tape device. This option is available only if you have a tape device installed on your computer. If you back up data to a tape device, the media will be managed by Removable Storage.
Set backup options
Backup provides an Options dialog box, which you can use to customize your backup operations. Using the Options dialog box, you can:
Select the type of backup that you want to do. Backup types include: copy, daily, differential, incremental, and normal. 
Select whether you want a log file to record your backup actions. If you select this option, you can also select whether you want a complete log file or summary log file.
Select whether you want to back up data that is stored on mounted drives.
Designate file types that you want to exclude from a backup operation.
Select whether you want to verify that the data was backed up correctly.
Start the backup
When you start a backup operation, Backup will prompt you for information about the backup job and give you the opportunity to set advanced backup options. After you have provided the information or changed your backup options, Backup will start backing up the files and folders you selected.
If you have scheduled the backup to run unattended, you will still be prompted for information about the backup job. However, after you have provided the information, Backup will not start backing up files; rather, it will add the scheduled backup to the Task Scheduler.
Notes

You must be an administrator or a backup operator to back up files and folders.

The registry, the HELP=glossary.hlp TOPIC=gls_ActiveDirectorydirectory service, and other key system components, are contained in the System State data. You must back up the System State data if you want to back up these components. 

You can only back up the System State data on a local computer. You cannot back up the System State data on a remote computer. 

You can schedule a backup so that it will run unattended at a specific time or frequency. You can schedule a backup after you click Start Backup. 

If you have Windows Media Services running on your computer, and you want to back up the files associated with these services, see "Running Backup with Windows Media Services" in the Windows Media Services online documentation. You must follow the procedures outlined in the Windows Media Services online documentation before you can back up or restore files associated with Windows Media Services. 

If you are using Removable Storage to manage media, or you are using Remote Storage to store data, then you should regularly back up the files that are in the following folders: 

Systemroot\System32\Ntmsdata
Systemroot\System32\Remotestorage
This will ensure that all of your Remote Storage and Removable Storage data can be restored.
Using batch files to back up data
You can perform backup operations from batch files using the ntbackup command followed by various command line parameters. However, there are two important limitations to using batch files to back up your data: 

Using the ntbackup command, you can back up entire folders only. You cannot designate individual files for backup. However, you can designate a backup selection file (.bks file) from the command line, which contains a list of files you want to back up. You must use the GUI version of the Backup utility to create backup selection files. 

The ntbackup command does not support the use of wildcard characters. For example, typing *.txt will not back up files with a .txt extension. 
Command line examples
The following examples show how to use the ntbackup command to back up files and folders from the command line or by using a batch file. 
Example 1:
ntbackup backup \\iggy-multi\c$ /m normal /j "My Job 1" /p "Backup" /n 
"Command Line Backup 1" /d "Command Line Functionality" /v:yes /r:no /l:s 
/rs:no /hc:on
This example will perform a normal backup named "My Job 1" of the remote share \\iggy-multi\c$. It will pull a tape from the Backup media pool, and name the tape "Command Line Backup 1." The description of the backup job will be "Command Line Functionality." The backup will be verified once the backup job is complete, access will not be restricted to the owner/administrator, the logging level will be set to summary only, Remote Storage data will not be backed up, and hardware compression will be enabled.
Example 2: 
ntbackup backup d:\ /j "My Job 2" /a /t "Command Line Backup 1" /m copy
This example will perform a copy backup named "My Job 2" of the local drive D:\. The backed up files and folders will be appended to the tape named "Command Line Backup 1." All other options will default to those specified in the Backup program. 
Example 3: 
ntbackup backup "@C:\Program Files\Windows NT\ntbackup\data\commandline.bks" 
/j "My Job 3" /t "Command Line Backup 1" /n "Command Line Backup 2"
This example will perform a backup using the backup type that is specified in the Backup program. It will use the backup selection file named Commandline.bks, located in the C:\Program Files\Windows NT\ntbackup\data\ directory to choose which files to backup. The backup job will be named "My Job 3" and it will overwrite the tape named "Command Line Backup 1" with the new name "Command Line Backup 2."
Example 4: 
ntbackup backup \\iggy-multi\d$ /j "Command Line Backup 4" /f "D:\backup.bkf"
ntbackup backup \\iggy-multi\d$ /j "Command Line Backup 5" /f "D:\backup.bkf" 
/a
ntbackup backup \\iggy-multi\d$ /j "Command Line Backup 6" /f "D:\backup.bkf"
The above examples show how to perform a backup to a file from the command line. All three examples use the Backup program's default values for the backup type, verification setting, logging level, hardware compression, and any other restrictions. The first example shows how to backup \\iggy-multi\d$ to the file D:\Backup.bkf. The second example shows how to append the same backup to the same file. The third example shows how to overwrite the file with the same backup. In all three examples a complete UNC name could be substituted for the drive letter (that is, instead of d:\backup.bkf, the user could specify \\iggy-multi\d$\backup.bkf as the backup destination).
Command line parameters
You can perform backup operations at the command prompt or from a batch file using the ntbackup command followed by various parameters. 
Syntax: 
ntbackup backup [systemstate] "bks file name" /J {"job name"} [/P {"pool name"}] [/G {"guid name"}] [/T { "tape name"}] [/N {"media name"}] [/F {"file name"}] [/D {"set description"}] [/DS {"server name"}] [/IS {"server name"}] [/A] [/V:{yes|no}] [/R:{yes|no}] [/L:{f|s|n}] [/M {backup type}] [/RS:{yes|no}] [/HC:{on|off}] [/UM] 
Parameters:
systemstate
Specifies that you want to back up the System State data. When you back up the System State data, all of the System State data is backed up, therefore, the /s switch does not apply. Also, the backup type will be forced to normal or copy.
bks file name
Specifies the name of the backup selection file (.bks file) to be used for this backup operation. A backup selection file contains information on the files and folders you have selected for backup. You have to create the file using the graphical user interface (GUI) version of Backup.
/J {"job name"} 
Specifies the job name to be used in the log file. The job name usually describes the files and folders you are backing up in the current backup job as well as the date and time you backed up the files.
/P {"pool name"} 
Specifies the media pool from which you want to use media. This is usually a subpool of the Backup media pool, such as 4mm DDS. If you select this you must not use the following switches: /A /G /F /T.
/G {"guid name"} 
Overwrites or appends to this tape. Do not use this switch in conjunction with /P.
/T {"tape name"} 
Overwrites or appends to this tape. Do not use this switch in conjunction with /P.
/N {"media name"} 
Specifies the new tape name. You must not use /A with this switch.
/F {"file name"} 
Logical disk path and file name. You must not use the following switches with this switch: /P /G /T.
/D {"set description"} 
Specifies a label for each backup set.
/DS {"server name"} 
Backs up the directory service file for the specified Microsoft Exchange Server.
/IS {"server name"} 
Backs up the Information Store file for the specified Microsoft Exchange Server.
/A
Performs an append operation. Either /G or /T must be used in conjunction with this switch. Do not use this switch in conjunction with /P.
/V:{yes|no}
Verifies the data after the backup is complete.
/R:{yes|no}
Restricts access to this tape to the owner or members of the Administrators group.
/L:{f|s|n}
Specifies the type of log file: f=full, s=summary, n=none (no log file is created).
/M {backup type}
Specifies the backup type. It must be one of the following: normal, copy, differential, incremental, or daily.
/RS:{yes|no}
Backs up the Removable Storage database.
/HC:{on|off}
Uses hardware compression, if available, on the tape drive.
/UM
Finds the first available media, formats it, and uses it for the current backup operation. You must use the /P switch to designate a device-type media pool when you use the /UM switch so that Backup searches for the appropriate type of media (for example, 4mm DDS). When you use the /UM switch, Backup will search the following media pools for available media: Free pool, Import pool, Unrecognized pool, and Backup pool. When available media is found, the search will stop and the media will be formatted and used without prompting you for input. This command is not applicable to tape loaders and should only be used if you have a stand-alone tape device.
Notes

You cannot restore files from the command line using the ntbackup command. 

The following switches will default to what you have already set using the graphical user interface (GUI) version of Backup unless they are changed by a command line switch: /V /R /L /M /RS /HC. For example, if hardware compression is turned on in the Options dialog box in Backup, it will be used if /HC is not specified on the command line. But if /HC:off is specified on the command line, it will override the Option dialog box setting and compression will not be used. 

If you have Windows Media Services running on your computer, and you want to back up the files associated with these services, see "Running Backup with Windows Media Services" in the Windows Media Services online documentation. You must follow the procedures outlined in the Windows Media Services online documentation before you can back up or restore files associated with Windows Media Services. 

You can only back up the System State data on a local computer. You cannot back up the System State data on a remote computer. 

If you are using Removable Storage to manage media, or you are using the Remote Storage to store data, then you should regularly back up the files that are in the following folders: 

Systemroot\System32\Ntmsdata
Systemroot\System32\Remotestorage
This will ensure that all Removable Storage and Remote Storage data can be restored.
Restoring files and folders
The following four steps describe a simple restore operation:
Select files and folders you want to restore
Backup provides you with a tree view of the files and folders that you have backed up, which you can use to select the files and folders that you want to restore. You can use this tree view the same way you use Windows Explorer to open drives and folders and select files.
Select where to restore your backed-up files and folders
Backup allows you to select one of three destinations for your restored files:
You can restore your backed-up data to the original folder or folders the data was in when you backed it up. This option is useful if you are restoring files and folders that have been damaged or lost.
You can restore your backed-up data to an alternate folder. If you select this option, the structure of the backed-up folders and files is retained in the alternate folder. This option is useful if you know you will need some old files, but you don't want to overwrite or change any of the current files or folders on your disk.
You can restore your backed-up files to a single folder. This option does not retain the structure of the backed-up folders and files. Only the backed-up files are placed in the single folder. This option is useful if you are searching for a file and you don't know its location.
Set restore options
Backup provides a Restore tab in the Options dialog box that lets you select how you want your files and folders restored. You must select one of three options:

Do not replace file on my computer. This will prevent files from being overwritten on your hard disk. This is the safest method of restoring files. 

Replace the file on disk only if the file on disk is older. If you have changed any files since you last backed up your data, this will ensure that you don't lose the changes you have made to the files.

Always replace the file on my disk. This will replace all of the files on your hard disk with the files in your backup set. If you have made any changes to files since you last backed up your data, this option will erase those changes.
Start the restore operation
When you start a restore operation, Backup will ask you to confirm that you are ready to restore data. You will also have the opportunity to set advanced restore options, including whether you want to restore security settings, the Removable Storage database, and junction point data.
Important   You can use Backup to back up and restore data on either FAT or NTFS volumes. However, if you have backed up data from an NTFS volume used in Windows 2000, it is recommended that you restore the data to an NTFS volume used in Windows 2000, or you could lose data as well as some file and folder features. For example, permissions, encrypting file system (EFS) settings, disk quota information, mounted drive information, and Remote Storage information will be lost if you back up data from an NTFS volume used in Windows 2000 and then restore it to a FAT volume or an NTFS volume used in Windows NT 4.0. 
Notes

You must be an administrator or a backup operator to back up files and folders.

The registry, the Active Directory directory service, and other key system components are contained in the System State data. You must back up the System State data if you want to back up and restore these components. 

If you restore the System State data, and you do not designate an alternate location for the restored data, Backup will erase the System State data that is currently on your computer and replace it with the System State data you are restoring. Also, if you restore the System State data to an alternate location, only the registry files, SYSVOL directory files, Cluster database information files, and system boot files are restored to the alternate location. The Active Directory directory services database, Certificate Services database, and COM+ Class Registration database are not restored if you designate an alternate location. 

In order to restore the System State data on a domain controller, you must first start your computer in Directory Services Restore Mode. This will allow you to restore the SYSVOL directory and the Active Directory. 

You can only restore the System State data on a local computer. You cannot restore the System State data on a remote computer. 

Administrators and Backup Operators can restore encrypted files and folders without decrypting the files or folders. 
Restoring a domain controller
If a domain has more than one domain controller, you can restore it in two ways. You can either restore Active Directory using replication with another domain controller, or restore Active Directory from backup media. If there are no domain controllers in the domain, then you can only restore Active Directory from backup media.
If possible, repair the system using the Emergency Repair Disk (ERD), and then continue with either of the next two steps.
If the system cannot be repaired using the ERD, or if you have suffered a major hardware malfunction and have had to totally rebuild the computer, you need to reinstall Windows 2000. Make sure the number and size of disk volumes is the same or larger than the previous system, and then proceed with either of the next two steps.
Restoring Active Directory from Backup media
Use Backup to restore the System State, which will recover Active Directory, File Replication Service (including Sysvol) and Certificate Services (if installed). If the domain controller computer has been replaced because of malfunction or the network adapters have been replaced, you might need to reconfigure the network settings manually.
For procedures on how to restore the system state, see To restore System State data.
To restore the System State data on a domain controller, you must first start your computer in directory services restore mode. Using this mode, you can restore the Sysvol directory and Active Directory. To restart your computer in safe mode, follow the instructions in To use safe mode and other startup options, and click Directory Service Restore Mode.
You can back up and restore the System State data only on a local computer, not a remote computer.
Restoring Active Directory with a replica
Use the Active Directory Installation wizard to reinstall Active Directory, promoting the server to a domain controller. Active Directory and Sysvol will be brought up-to-date through replication from a domain controller. Before you run the Active Directory Installation wizard, delete any references to the old domain controller using the Sites and Services snap-in.
Notes

You must be an administrator or a backup operator to back up files and folders. 

The registry, Active Directory, and other key system components are contained in the System State data. You must back up the System State data if you want to back up and restore these components. 

If you restore the System State data and you do not designate an alternate location for the restored data, Backup erases the System State data that is currently on your computer and replaces it with the System State data you are restoring. Also, if you restore the System State data to an alternate location, only the registry files, Sysvol, directory files, and system boot files are restored to the alternate location. The Active Directory database, the Certificate Services database, and the Component Services database are not restored if you designate an alternate location. 

Administrators and backup operators can restore encrypted files and folders without decrypting the files or folders. 
Recovery Console commands
The following commands can be used with the Windows 2000 Recovery Console:

Attrib 

Changes the attributes of a file or directory.

Batch 

Executes the commands specified in the text file.

ChDir (Cd) 

Displays the name of the current directory or changes the current directory.

Chkdsk 

Checks a disk and displays a status report.

Cls 

Clears the screen.

Copy 

Copies a single file to another location.

Delete (Del) 

Deletes one or more files.

Dir 

Displays a list of files and subdirectories in a directory.

Disable 

Disables a system service or a device driver.

Diskpart 

Manages partitions on your hard drives.

Enable 

Starts or enables a system service or a device driver.

Exit 

Exits the Recovery Console and restarts your computer.

Expand 

Extracts a file from a compressed file.

Fixboot 

Writes a new partition boot sector onto the system partition.

Fixmbr 

Repairs the master boot record of the partition boot sector.

Format 

Formats a disk.

Help 

Displays a list of the commands you can use in the Recovery Console.

Listsvc 

Lists the services and drivers available on the computer.

Logon 

Logs on to a Windows 2000 installation.

Map 

Displays the drive letter mappings.

Mkdir (Md) 

Creates a directory.

More 

Displays a text file.

Rename (Ren) 

Renames a single file.

Rmdir (Rd) 

Deletes a directory.

Set 

Displays and sets environment variables.

Systemroot 

Sets the current directory to the systemroot directory of the system you are currently logged on to.

Type 

Displays a text file.
Additional information on starting and using the Recovery Console is available. If you are using Windows 2000 Professional, see the Windows 2000 Professional Getting Started online book, or the Windows 2000 Professional Getting Started book that came with your Windows 2000 CD. If you are using Windows 2000 Server, see the Disaster Recovery How to section.
Resources

Windows 2000 Server family at Microsoft Windows.(http://www.microsoft.com/windows) 

Hardware compatibility list at the Microsoft Web site.(http://www.microsoft.com/) 

Microsoft TechNet at Microsoft TechNet.(http://www.microsoft.com/technet) 

Microsoft TechNet compact disks. 

Microsoft support at the Microsoft Web site.(http://www.microsoft.com/) 

Getting Started for Windows 2000 Server. 

Windows 2000 Server Resource Kit. 

Windows 2000 Server Registry. 

Updated technical information. 
Troubleshooting
What problem are you having?
The system will not start.
Cause: One of several problems could be preventing you from starting your computer. These include problems with your registry, system files, partition boot sector, and startup environment. However, you cannot repair your system unless you have created an Emergency Repair Disk (ERD), which you can do in the Backup utility.
Solution: You can use the Windows 2000 repair feature to fix these problems.
The following steps provide a general overview of the repair process:
 1.
Start your computer from the Windows 2000 Setup disks or the CD. 
 2.
Choose the repair option during setup. 

After Setup finishes copying files from the last Setup disk, you begin the text-based Windows 2000 installation process. During this process, you can choose whether you want to install a fresh version of Windows 2000, or whether you want to repair or recover an existing installation of Windows 2000. To repair a damaged or corrupted system, you should select the repair option.
 3.
Choose the type of repair. 

You can choose either the fast repair option, which is the easiest and does not require any user interaction, or you can choose the manual repair option, which requires user interaction. The fast repair option attempts to repair problems related to the registry, system files, the partition boot sector on your boot volume, and your startup environment (if you have a dual-boot or multiple-boot system). Using the manual repair option, you can choose whether you want to repair system files, partition boot sector problems, and startup environment problems, but you cannot repair problems with your registry. For example, using the manual repair option, you can attempt to repair your system files if you know that your partition boot sector and your startup environment are both intact.
 4.
Start the repair process. 

To start the repair process, you need the 1.44-megabyte (MB) ERD that you created in the Backup utility, and the original Windows 2000 installation CD. During the repair process, missing or corrupted files are replaced with files either from the Windows 2000 CD or the systemroot\repair directory, which means any changes you made to the system after you originally installed Windows 2000 or since you last created an ERD could be lost.
 5.
Restart your computer. 

If the repair process was successful, you are prompted to restart your computer. You should then have a working system.
Important   When you create an ERD, information about your current system settings is saved in the systemroot\repair folder. If you delete or change this folder, you might not be able to repair problems with your system. 
Notes

The manual repair option should be used only by advanced users or administrators. 

The fast repair option repairs a registry file only if the file is missing or corrupted. 
Fault Tolerance
You implement fault tolerance to keep your computer running in the event of a component or system failure.

Before creating RAID disk sets or adding a UPS device, see Checklists. 

To find features that have been moved in Windows 2000 Server, see New ways to do familiar tasks. 

For tips about using fault tolerance, see Best practices. 

For help with specific tasks, see How to. 

For general background information, see Concepts. 

For problem-solving instructions, see Troubleshooting. 
Checklists

Checklist: Creating a mirrored volume 

Checklist: Creating a RAID-5 volume 

Checklist: Configuring a UPS 
Checklist: Creating a mirrored volume

Step
Reference

Review key concepts.
Using mirrored volumes;
Best practices;
To restore disk configuration information

Confirm that you are a member of the Administrators group.
Groups overview

Back up existing data.
To back up files with the backup wizard

Create the volume.
To create a mirrored volume
Checklist: Creating a RAID-5 volume

Step
Reference

Review key concepts.
Using RAID-5 volumes;
Best practices;
Choosing a RAID method;
To restore disk configuration information

Confirm that you are a member of the Administrators group.
Groups overview

Back up existing data.
Backing up and restoring data

Create the volume.
To create a RAID-5 volume
Checklist: Configuring a UPS

Step
Reference

Review key concepts.
Uninterruptible Power Supplies (UPS);
Best practices

Confirm that you are a member of the Administrators group.
Groups overview

Back up existing data.
To back up files with the backup wizard

Configure a program to run at low battery level.
Install a UPS

Test your UPS configuration.
To test your UPS configuration
New Ways to do Familiar Tasks
The following table compares familiar Windows NT 4.0 fault tolerance tasks with the equivalent tasks in Windows 2000. 
If you want to
In Windows NT 4.0 use
In Windows 2000 use
Create a mirror set
Disk Administrator in Administrative tools.
Computer Management (Local) in Administrative tools. For more information, see Manage mirrored volumes.
Create a RAID-5 set
Disk Administrator in Administrative tools.
Computer Management (Local) in Administrative tools. For more information, see To create a RAID-5 volume.
Configure a UPS device
UPS in Control Panel.
Power Options in Control Panel. For more information, see To configure a UPS.
Best Practices

Mirroring the system and boot volumes
Mirror the boot and system volumes onto another disk. If one of the disks containing the boot and system volumes fails, you can start the computer from the disk containing the mirrors of these volumes. 

Upgrading basic RAID disks to dynamic disks
Upgrade basic disks that belong to RAID arrays to dynamic disks. If a member disk of a RAID array fails, you can add a new disk to the computer and then rebuild the new member without rebooting the computer, thereby saving time. 

Testing an uninterruptible power supply (UPS)
Test the UPS device by simulating a power failure. You can do this by disconnecting the power to the device. This will enable you to determine whether the UPS is configured correctly, and how long the computer will run before the battery runs out of energy. For more information, see To test your UPS configuration. 

Selecting a UPS
Select a UPS device that not only includes a battery, but can also take advantage of the alerting features of the Windows UPS service in the event of a power failure. These features include main-power failure detection, low-battery detection, and UPS shutdown. Confirm that your UPS device works with Windows by checking the Microsoft Windows Hardware Compatibility List at the Microsoft Web site (http://www.microsoft.com/). It may be necessary to order the correct serial cable from the UPS manufacturer. This cable is designed to follow the UPS interfacing specification for Windows 2000. If you are upgrading your computer to Windows 2000 and you already have a UPS, check with the manufacturer to make sure the existing cable works with Windows 2000. Unexpected results can occur if you use the wrong cable. 

Executing a command
If you set Power Options to execute a command file following main power failure, make sure the command file finishes running in 30 seconds. A run time that is greater than 30 seconds threatens the capability of Windows to complete a graceful system shutdown. For more information, see To configure a UPS. 
How To...

Use RAID disks 

Use an uninterruptible power supply (UPS) 
Use RAID disks

Create a mirrored volume 

Add a mirror to an existing simple volume 

Resynchronize a mirrored volume 

Break a mirrored volume into two volumes 

Remove a mirror from a mirrored volume 

Create a RAID-5 volume 
To create a mirrored volume
 1.
Open Disk Management. 
 2.
Right-click the unallocated space on one of the dynamic disks where you want to create the mirrored volume, and then click Create Volume. 
 3.
In the Create Volume wizard, click Next, click Mirrored volume, and then follow the instructions on your screen. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management. 

You can create mirrored volumes only on computers running Windows 2000 Server. 

You need at least two dynamic disks to create a mirrored volume. 

Mirrored volumes are fault tolerant. 

Mirrored volumes cannot be extended or striped. 

The same drive letter is used for both copies (mirrors) of a mirrored volume. 
To add a mirror to an existing simple volume
 1.
Open Disk Management. 
 2.
Right-click the simple volume you want to mirror, click Add Mirror, and then follow the instructions on your screen. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management. 

You can mirror volumes only on computers running Windows 2000 Server. 

Any existing simple volume can be mirrored onto another dynamic disk, as long as there is sufficient unallocated space on that disk. If you don't have a dynamic disk with enough unallocated space, the Add Mirror command is unavailable. (To verify you have enough space, right-click the disk, click Properties, and then check the size in Unallocated Space. This size may be slightly smaller than shown in the graphical and list views.) 

Mirrored volumes are fault tolerant. 

You cannot extend a simple volume after it has been mirrored. 

The same drive letter is used for both copies (mirrors) of a mirrored volume. 
To resynchronize a mirrored volume
 1.
Open Disk Management. 
 2.
Right-click the mirrored volume you want to resynchronize, and then click Resynchronize Mirror. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management. 

In most cases, mirrored volumes on dynamic disks are resynchronized automatically. However, you need to use the Resynchronize Mirror command for mirrored volumes (mirror sets) on basic disks. 

You resynchronize a mirrored volume when data on one of the disks becomes stale. For example, if one disk of a mirrored volume is disconnected, data is written to the remaining disk, but the volume is no longer fault tolerant. If you reconnect the disk, the data on the reconnected disk is stale. To make the mirrored volume fault tolerant again, you must resynchronize the mirrored volume to update the information on the reconnected disk. 
To break a mirrored volume into two volumes
 1.
Open Disk Management. 
 2.
Right-click a volume in the mirrored volume, and then click Break Mirror. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management. 

When you break a mirrored volume, the two volume copies that made up the mirrored volume become two independent simple volumes. These volumes are no longer fault tolerant. 
To remove a mirror from a mirrored volume
 1.
Open Disk Management. 
 2.
Right-click the mirror you want to remove, click Remove Mirror, and then follow the instructions on your screen. 
Important   Once you remove a mirror from a mirrored volume, the removed mirror becomes unallocated space and the remaining mirror becomes a simple volume that is no longer fault tolerant. All of the data on the removed mirror is deleted. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management.
To create a RAID-5 volume
 1.
Open Disk Management. 
 2.
Right-click the unallocated space on one of the dynamic disks where you want to create the RAID-5 volume, and then click Create Volume. 
 3.
In the Create Volume wizard, click Next, click RAID-5 volume, and then follow the instructions on your screen. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open Disk Management, click Start, point to Settings, click Control Panel, double-click Administrative Tools, and then double-click Computer Management. In the console tree under Storage, click Disk Management. 

You can create RAID-5 volumes only on computers running Windows 2000 Server. 

You need at least three dynamic disks to create a RAID-5 volume. A RAID-5 volume can span a maximum of 32 disks. 

RAID-5 volumes provide fault tolerance at a cost of only one additional disk for the volume. This means that if you use three 10-GB disks to create a RAID-5 volume, the volume will have a 20-GB capacity. The remaining 10-GB is used for parity. 

RAID-5 volumes cannot be extended or mirrored. 
Use an Uninterruptible Power Supply (UPS)

Install a UPS 

Remove a UPS 

Configure a UPS 

Configure a simple-signalling UPS 

Test your UPS configuration 
To install a UPS
 1.
Open Power Options in Control Panel. 
 2.
On the UPS tab, click Select. 
 3.
In the UPS Selection dialog box, under Select manufacturer, click the manufacturer of the UPS attached to the computer. 
 4.
Under Select model, click the model of UPS attached to the computer. 
 5.
Under On port, click the serial port where the UPS is attached, and then click Finish. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To remove a UPS
 1.
Open Power Options in Control Panel. 
 2.
On the UPS tab, click Select. 
 3.
In the UPS Selection dialog box, under Select manufacturer, click None. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To configure a UPS
 1.
Open Power Options in Control Panel. 
 2.
On the UPS tab, click Configure. 
 3.
In the UPS Configuration dialog box, change one or more of the following settings: 

Enable all notifications

Select this check box if you want Windows 2000 to display a warning message when the computer switches to UPS power. You can specify the number of seconds to wait before displaying the initial power failure warning message and the number of seconds that must elapse before displaying subsequent power failure messages.

Critical alarm

Select the Minutes on battery before critical alarm check box if you want Windows 2000 to allow the computer to run on UPS for a set number of minutes before the critical power alarm. 

Select the When the alarm occurs, run this program check box if you want Windows 2000 to run a program or task when the UPS activates the critical power alarm. 
 1.
Click Configure. 
 2.
In the UPS System Shutdown Program dialog box, in Run, type the program or task to run before the UPS shuts down the computer, or click Browse to search for a program or task. 
 3.
On the Schedule tab, customize the task's schedule as appropriate. 
 4.
On the Settings tab, customize the settings for scheduled task completion, idle time, and power management as appropriate. 

In the Next, instruct the computer to list, click the system state you want the computer to enter when the critical power alarm occurs. 

Select the Finally, turn off the UPS check box if you want the UPS to shut down when the computer is shut down. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

The command file must reside in your systemroot\System32 folder and have one of the following extensions: .exe, .com, .bat, or .cmd. 

You cannot specify a command file that causes a dialog box to appear, because dialog boxes that require user input can impede a graceful system shutdown. The command file must finish running in 30 seconds. A run time that is greater than 30 seconds threatens the capability of Windows to complete a graceful system shutdown. 

After configuring UPS options, be sure to test your UPS configuration to confirm that your computer is protected from power failure. 

The options for configuring the UPS service depend on the specific UPS hardware installed on your system. Incorrect settings can cause undesirable operation of your UPS hardware. For details about possible settings, see the documentation for your UPS device. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To configure a simple-signalling UPS
 1.
Open Power Options in Control Panel. 
 2.
On the UPS tab, click Configure. 
 3.
In the UPS Interface Configuration dialog box, set the UPS signal polarities as appropriate for: 

Power Fail/On Battery 

Low Battery 

UPS Shutdown 
Caution   Before changing these settings, see the documentation that came with your UPS. 
Notes

You must be logged on as an administrator or a member of the Administrators group in order to complete this procedure. If your computer is connected to a network, network policy settings may also prevent you from completing this procedure. 

To open a Control Panel item, click Start, point to Settings, click Control Panel, and then double-click the appropriate icon. 

Using Power Options in Control Panel, you can adjust any power management option that your computer's hardware configuration supports. Because these options may vary widely from computer to computer, the options described may differ from those available on your computer. Power Options automatically detects what is available on your computer and shows you only the options that you can control.
To test your UPS configuration
 1.
Simulate a power failure by disconnecting the power to the UPS device. 
 2.
Wait until the UPS battery reaches a low level, at which point system shutdown should occur. 
 3.
Restore power to the UPS device. 
 4.
Check the system log in Event Viewer to ensure that all actions were logged and that there were no errors. 
Caution   Save and close any open documents before performing system tests like this one. 
Notes

After you disconnect the power to the UPS device, the computer and peripherals connected to the UPS device should continue operating and a warning message should appear on the screen. 

If the UPS service is configured to run a command file, ensure that the file executes in under 30 seconds. Failure to complete execution in 30 seconds jeopardizes the safe shutdown of your Windows 2000 computer. 
Concepts
This section provides general background information about the fault-tolerance capabilities of Windows 2000.

Fault tolerance overview 

Understanding fault tolerance 

Using fault-tolerant devices 

Resources 
Fault tolerance overview
Fault tolerance is the ability of a system to continue functioning when part of the system fails. Normally, fault tolerance is used in describing disk subsystems, but it can also apply to other parts of the system or the entire system. Fully fault-tolerant systems use redundant disk controllers and power supplies as well as fault-tolerant disk subsystems. You can also use an uninterruptible power supply (UPS) to safeguard against local power failure.
Although the data is always available and current in a fault-tolerant system, you still need to make backups to protect the information on your disk subsystem against user errors and destructive events such as fire, earthquakes, tornadoes, and floods. Disk fault tolerance is not an alternative to a backup strategy with offsite storage.
You can use dynamic storage to create volume-oriented disk systems that are fault tolerant. The new Disk Management architecture allows online changes without the need to restart your computer. To learn more about dynamic storage, see Disk Management.
Understanding fault tolerance
This section covers:

RAID disk arrays 

Choosing a RAID method 

Uninterruptible power supplies (UPS) 
RAID disk arrays
Strategies for implementing a Redundant Array of Independent Disks (RAID) can use hardware or software solutions. In a hardware solution, the controller interface handles the creation and regeneration of redundant information. In Windows, this activity can be performed by the software. In either case, data is stored across an array of disks.
Disk arrays consist of multiple disk drives coordinated by a controller. Individual data files are typically written to more than one disk in a manner that, depending on the RAID level used, can improve performance or reliability.
However, there is no fault tolerance until the fault is repaired. Few RAID implementations can withstand two simultaneous failures. When the failed disk is replaced, the data can be regenerated by using the redundant information. Data regeneration occurs without bringing in backup tapes or performing manual update operations to cover transactions that took place since the last backup. When data regeneration is complete, all data is current and again protected against disk failure. The ability to provide cost-effective high data availability is the key advantage of disk arrays.
Choosing a RAID method
The major differences between mirrored volumes and RAID-5 volumes are hardware requirements, performance, and cost. The following table illustrates the major features of the two methods of fault tolerance:
Mirrored volumes
RAID-5 volumes
Support FAT and NTFS.
Support FAT and NTFS.
Can mirror system or boot volumes.
Cannot stripe system or boot volumes.
Require 2 hard disks.
Require a minimum of 3 hard disks.
Have higher cost per megabyte (50 percent utilization).
Have lower cost per megabyte.
Have good read and write performance.
Have moderate write performance and excellent read performance.
Use less system memory.
Require more system memory.
Support only 2 hard disks.
Support up to 32 hard disks.
Choosing between mirrored and RAID-5 volumes depends on your computing environment. RAID-5 volumes are a good solution for data redundancy when most activity consists of reading data. For example, if your network has a server on which you maintain all copies of the programs used by the people at that site, this might be a good case for using a RAID-5 volume. It enables you to protect the programs against the loss of a single disk in the striped volume. In addition, the read performance improves because of the concurrency of the reads across the disks that make up the RAID-5 volume.
In an environment in which frequent updates to the information occur, using mirrored volumes is usually better. However, you can use a RAID-5 volume if you want redundancy and if the storage overhead cost of a mirror is prohibitive.
Notes

Fault-tolerant disk structures from Windows NT 4.0, such as mirror sets or striped sets with parity, are still supported. For information on maintaining them, see Using mirror sets and stripe sets with parity. If you want to convert them into mirrored or RAID-5 volumes, see To upgrade a basic disk to a dynamic disk. 

Operating systems such as MS-DOS that do not have fault-tolerance functionality cannot recognize the volumes that Windows 2000 Server creates for fault tolerance. Therefore, if you mirror your MS-DOS system volume on a dual-boot computer, MS-DOS cannot use or start either volume. Also, as a precaution, create a boot disk so that you can start your computer from the mirrored volume if the system volume is lost.
Uninterruptible power supplies (UPS)
A UPS provides power when the local power fails. It is usually rated to provide a specific amount of power for a specific period of time. This power comes from batteries that are kept charged while main power is available. Usually, all that is needed from a UPS is time to shut down the system in an orderly fashion by quitting processes and closing sessions.
Many UPS devices can communicate with operating systems, enabling the operating system to notify users automatically of the pending shutdown process or provide notification that the power has been restored and a shutdown is no longer necessary.
During a power failure, the UPS service immediately pauses the Server service to prevent any new connections and sends a message to notify users of the power failure. The UPS service then waits a specified interval of time before notifying users to quit their sessions. If power is restored during the interval, another message is sent to inform users that power has been restored and normal operations have resumed.
Using fault-tolerant devices
This section covers:

Using RAID 

Using UPS 
Using RAID
This section covers:

Using mirrored volumes 

Using RAID-5 volumes 

Repairing RAID disks 
Using mirrored volumes
Mirrored volumes, called mirror sets in Windows NT 4.0, provide an identical copy for a selected disk. Because all data written to the primary disk is also written to a secondary or mirror disk, it uses only 50 percent of disk space. If one disk fails, the system uses data from the other disk.
Mirrored volumes protect a volume on a disk from media and, possibly, controller failure by maintaining a fully redundant copy on another disk. When a mirrored volume fails, you must break the mirrored volume to expose the remaining volume as a separate volume with its own drive letter. You can then create a new mirrored volume with unused free space of the same size or greater on another disk.
To create a mirrored volume, you create a volume using free space on another disk. If the second volume is larger, the remaining space becomes free space. The same drive letter is used for both volumes. Any existing volume, even the system and boot volumes, can be mirrored onto another volume of the same size, or greater, on another disk using either the same or a different controller. When creating mirrored volumes, it is best to use disks that are the same size, model, and manufacturer.
Mirrored volumes have better overall read and write performance than RAID-5 volumes. Another advantage of mirrored volumes over RAID-5 volumes is that there is no loss in performance when a member of a mirrored volume fails. Mirrored volumes are more expensive in terms of dollars per megabyte because disk space utilization is less. However, the entry cost of a mirrored volume is lower because it requires only two disks, whereas RAID-5 volumes require three or more disks.
Mirrored volumes reduce the chance of an unrecoverable error by providing a duplicate set of data, which doubles the number of disks required and the input/output (I/O) operations when writing to the disk. However, some performance gains are achieved for reading data because of I/O load balancing of requests between the two volumes.
When you want to use the space in a mirrored volume for other purposes, you must first break the mirrored volume relationship and then delete one of the volumes. Breaking the mirrored volume does not delete the information, but it is still safer to do a backup first.
In the case of an unrecoverable error on a volume within a mirrored volume, you need to break the mirrored volume relationship to expose the remaining volume as an individual volume. You can then reassign some free space on another disk to create a new mirrored volume.
For information about how to create, break, or repair a mirrored volume, or to add a volume to or remove a volume from an existing mirrored volume, see Manage mirrored volumes. 
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Using RAID-5 volumes
RAID-5 volumes, called striping with parity in Windows NT 4.0, share data across all the disks in an array. RAID level 5 is unique because it writes the parity information to all the disks. Data redundancy is achieved by arranging a data block and its parity information on different disks in the array.
RAID-5 volumes have better read performance than mirrored volumes. However, when a member is missing, such as when a disk has failed, the read performance is degraded by the need to recover the data with the parity information.
Nevertheless, this strategy is recommended over mirrored volumes for applications that require redundancy and are primarily read-oriented. Write performance is reduced by the parity calculation. Also, a write operation requires three times more memory than a read operation during normal operation. Moreover, when a volume fails, reading requires at least three times more memory. Both conditions are caused by the parity calculation.
Understanding parity usage in RAID-5 volumes 
The data redundancy method used in Windows 2000 for RAID-5 volumes is a function of the Boolean operation called exclusive OR, also called XOR. The important concept to remember about parity is that regeneration uses the parity information with the data on the good disks to re-create the data on the failed disk. RAID-5 fault tolerance maintains an XOR value of the total data. This enables the reconstruction of missing data (on a failed disk or sector) from the remaining disks in the RAID-5 volume.
RAID-5 volumes include one parity block per stripe. Therefore, you must use at least three, rather than two, disks to allow for the parity information. Parity stripes, as shown in the following illustration, are distributed across all the volumes to balance the I/O load.
RAID-5 provides data redundancy at a cost of only one additional disk for the volume. However, recovery from the failure of a disk in a RAID-5 volume is more time consuming than for a mirrored volume.
When you want to recover the space in a RAID-5 volume for other purposes, be sure to back up the information in it first, if you want to reuse that information. Then delete the volume.
For information about how to create and repair RAID-5 volumes, see Use RAID disks.
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Repairing RAID disks
You use the Windows 2000 fault-tolerance utilities to recover quickly and easily from problem situations. Using mirrored volumes, you have instant access to another disk with a redundant copy of the information on a failed disk. With RAID-5 volumes you can regenerate data by using the parity stripe if a disk fails. Bad-sector mapping capabilities enable the system to fix sector failures without user intervention. 
This section briefly discusses how to recover data from a failed disk in a mirrored or RAID-5 volume and from sector failures:

Fixing mirrored volumes and RAID-5 volumes 

Fixing sector failures 
Fixing mirrored volumes and RAID-5 volumes
When a member of a mirrored volume or a RAID-5 volume fails, it becomes an orphan. Windows then determines that it can no longer use it and directs the reading and writing of all new data to the remaining members of the fault-tolerance volume.
When a member of a mirrored volume is orphaned, you must first break the mirrored volume relationship to expose the remaining volume as a separate volume. The remaining working member of the mirrored volume receives the drive letter that was previously assigned to the complete mirrored volume. The orphaned volume receives the next available drive letter or whatever letter you want to assign to it.
You can then create a new mirrored volume relationship from unused free space on another disk. When you restart the computer, the data from the good volume is copied to the new member of the mirrored volume.
For information about repairing a mirrored volume, see Repairing a dynamic mirrored volume.
When a member of a RAID-5 volume is orphaned, you can regenerate the data for the orphaned member from the remaining members. In Disk Management, select a new area of free space that is the same size as or larger than the other members of the RAID-5 volume, and then regenerate the data. If you are required to restart the computer, the fault-tolerance driver reads the information from the stripes on the other member disks and then re-creates the data of the missing member and writes it to the new member.
To regenerate a RAID-5 volume, the volume must be locked by the operating system. All network connections to the volume are lost when a volume is regenerated.
For information about repairing a RAID-5 volume, see Repairing a dynamic RAID-5 volume.
Note   The comments in this section regarding RAID-5 volumes and mirrored volumes on dynamic disks also apply to stripe sets with parity and mirror sets on basic disks.
Fixing sector failures
The file system verifies all sectors when it formats a volume. All faulty sectors are spared from service. Windows 2000 fault-tolerance services add sector-recovery capabilities to the system.
When a sector I/O failure occurs in a fault-tolerant system with redundant copies of the data, the fault-tolerance driver attempts to spare the bad sector from use. Small Computer System Interface (SCSI) devices can do this, but AT devices, such as Integrated Device Electronics (IDE) and Enhanced Small Device Interface (ESDI), cannot.
When the sector cannot be spared, the correct information obtained from the redundant copy is returned to the file system with a status message disclosing a faulty sector in the I/O. The file system then attempts to locate the failure and spare the bad sectors by removing them from the sector map of the file system. An error message is logged in Event Viewer about the potential for data loss if the partition containing the redundant copy also fails.
You can also use Disk Management to check for errors on your disk. In Properties for the disk, on the Tools menu, click Error-checking.
Using UPS
This section covers:

Using a UPS device with Windows 

Running a command file upon UPS shutdown 
Using a UPS device with Windows
You should use the following Windows services in combination with the uninterruptible power supply (UPS) device that you select for your computer: UPS, Alerter, Messenger, and Event Log. For other recommendations, see Best practices.
To configure the UPS service, in Control Panel, click UPS. You should base the configuration on the features supported by the UPS device that you are using. The three features that Windows 2000 supports are:

Main-power failure detection. 

Low-battery detection. 

UPS shutdown capability. 
To determine the correct settings, read the user's manual for your UPS device carefully, or contact the manufacturer. Based on the features supported by the UPS, you might have to enter additional settings under UPS Characteristics in the UPS dialog box.
The UPS service can be controlled in several ways. One way is to configure the settings in the UPS dialog box. A message appears and asks whether you want to start the UPS service. Another way to start the service is to click Services in Control Panel.
The Alerter and Messenger services are started automatically when Windows 2000 starts. The Alerter service sends alerts to selected users, and the Messenger service sends messages to your local Windows 2000–based computer and to other users on the network. All detected power fluctuations and power failures are recorded in the event log, along with UPS service start failures and server shutdown initiations.
To ensure that the computer is protected from power failures, test it by simulating a power failure; that is, by disconnecting the main power supply to the UPS device. Your computer and peripherals connected to the UPS device should remain operational, messages should be displayed, and events logged. Wait until the UPS battery reaches a low level to verify that a graceful shutdown occurs. Restore the main power to the UPS device, and check the event log to verify that all actions were logged and there were no errors.
Running a command file upon UPS shutdown
You can define command files for the Windows uninterruptible power supply (UPS) service. However, you should specify a command file only if your system requires special actions prior to a system shutdown. For example, if you have a custom program running that is connected to another computer, you can use the command file to end the session and log off the connected computer automatically prior to system shutdown.
You cannot specify a command file that causes a dialog box to appear because dialog boxes that require user input can impede a graceful system shutdown.
The command file must reside in your Systemroot\System32 directory and have one of the following extensions: .exe, .com, .bat, or .cmd. For help with running a command file, see To configure a UPS.
Note   The command file must finish running in 30 seconds. A run time that is greater than 30 seconds threatens the capability of Windows to complete a graceful system shutdown. You should test the operation of the command file under a worst-case scenario.
Resources

Windows 2000 Server family at Microsoft Windows (http://www.microsoft.com/windows) 

Microsoft Windows Hardware Compatibility List at the Microsoft Web site (http://www.microsoft.com/) 

Microsoft TechNet at Microsoft TechNet (http://www.microsoft.com/technet) 

Microsoft TechNet compact disks 

Microsoft support at the Microsoft Web site (http://www.microsoft.com/) 

Getting Started for Windows 2000 Server 

Windows 2000 Server Resource Kit 

Windows 2000 Server Registry 

Updated technical information 
Troubleshooting
What problem are you having?
A mirrored volume's status is Failed Redundancy
Cause: One or both of the members of the mirrored volume has failed, and the volume is no longer fault tolerant.
Solution: If the disk's status is Offline, see To reconnect the disk and repair the mirrored volume. If the disk's status is Online (Errors), see To reactivate the disk. The disk's status might be Missing if it cannot be accessed at all.
The RAID-5 volume's status is Failed Redundancy
Cause: One or all of the members of the RAID-5 volume has failed and the volume is no longer fault tolerant.
Solution: If the disk's status is Offline, see To reconnect the disk and repair the RAID-5 volume.
Disaster Recovery
Disaster recovery includes how to prepare for system problems, how to use options that can help start a system that otherwise would not start, and how to use the repair and recovery options available in Windows 2000. 

To prepare for disaster recovery, see Checklists. 

To find features that have been moved in Windows 2000 Server, see New ways to do familiar tasks. 

For tips about using disaster recovery, see Best practices. 

For help with specific tasks, see How to. 

For general background information, see Concepts. 

For problem-solving instructions, see Troubleshooting. 
Checklists

Checklist: Safeguarding your system 

Checklist: Recovering a system that will not start 
Checklist: Safeguarding your system
You can take a number of steps as safeguards against the possibility of disk failure or other serious system problems.

Step
Reference

Specify what you want Windows 2000 to do if the system stops unexpectedly. For example, you can specify that you want your computer to restart automatically and that it can control logging options.
Specify what Windows 2000 does if the system stops unexpectedly 

Keep a set of boot disks for Windows 2000 where they can be accessed. This can be either the compact disc (CD) for Windows 2000 (for computers that can start from the CD drive) or a set of floppy disks that you create from the CD.
To create boot disks

Use Backup to create an Emergency Repair Disk.
To create an Emergency Repair Disk
Checklist: Recovering a system that will not start

Step
Reference

Try safe mode and related startup options, which you can use to start the system with only the minimal necessary services.
Safe mode startup options 

An option to consider if safe mode does not help is the Recovery Console. This option is recommended only for advanced users or administrators.
The Recovery ConsoleTo start the computer and use the Recovery Console

If safe mode and the Recovery Console are not workable in your situation, and if you made appropriate advance preparations, you can try the Emergency Repair Disk option.
To use an Emergency Repair Disk for system repairs 
New Ways to do Familiar Tasks
The following table compares familiar Windows NT 4.0 fault tolerance tasks with the equivalent tasks in Windows 2000. 
If you want to
In Windows NT 4.0 use
In Windows 2000 use
Create a mirror set
Disk Administrator in Administrative tools.
Computer Management (Local) in Administrative tools. For more information, see Manage mirrored volumes.
Create a RAID-5 set
Disk Administrator in Administrative tools.
Computer Management (Local) in Administrative tools. For more information, see To create a RAID-5 volume.
Configure a UPS device
UPS in Control Panel.
Power Options in Control Panel. For more information, see To configure a UPS.
Best Practices

Separating the boot and system volumes
Put the Windows 2000 Server system and boot volumes and the data volumes on separate drives. This greatly simplifies recovery if a disk is damaged. 

Saving the disk configuration
Save the disk configuration data each time you change the configuration using Disk Management. 

Keeping a written record
Keep a written record of disk volumes and their sizes to have during disk recovery. Attach this information to the front of each disk drive. 
How To...

Safeguard a system 

Recover a system that will not start 
Safeguard a system

Create boot disks 

Create an Emergency Repair Disk 
To create boot disks
 1.
Obtain four blank, formatted, 3.5-inch, 1.44-megabyte (MB) floppy disks. 
 2.
Insert one of the disks into the floppy disk drive on a computer running any version of Windows or MS-DOS. 
 3.
Insert the Windows 2000 compact disc (CD) into the CD-ROM drive. 
 4.
Click Start, and then click Run. 
 5.
In the Open box, type d:\bootdisk\makeboot a: (where d is the drive letter assigned to your CD-ROM drive), and then click OK. 
 6.
Follow the screen prompts. 
Notes

Disks created from the Windows 2000 Professional CD cannot be used with Windows 2000 Server; the reverse combination also does not work. 

Before deciding that a computer must be started from a CD or floppy disks, you should first try starting in safe mode on that computer. 

After starting a disabled computer from floppy disks, you can then use the Recovery Console or the Emergency Repair Disk (if you have prepared one). 
To create an Emergency Repair Disk
 1.
Obtain a blank, formatted 1.44-megabyte (MB) floppy disk. 
 2.
Open Backup. 
 3.
On the Welcome tab, click Emergency Repair Disk. 
 4.
Follow the instructions that appear on your screen. 
Important   When you complete Setup, information about your original system settings is saved in the systemroot\Repair folder on the system partition. If you use the Emergency Repair Disk to repair your system, the information in this folder can be accessed. You must not change or delete this folder. 
Note   To open Backup, click Start, point to Programs, point to Accessories, point to System Tools, and then click Backup. 
Recover a system that will not start

Start Windows 2000 in safe mode 

Start Windows 2000 using the Last Known Good Configuration 

Start your computer at a command prompt 

Start the computer and use the Recovery Console 

Use an Emergency Repair Disk for system repairs 
To start Windows 2000 in safe mode
 1.
Click Options, and then click Print to print these instructions. They will not be available after you shut your computer down in step 2. 
 2.
Click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Please select the operating system to start, press F8. 
 5.
Use the arrow keys to highlight the appropriate safe mode option, and then press ENTER. 

NUM LOCK must be off before the arrow keys on the numeric keypad will function.
 6.
Use the arrow keys to highlight an operating system, and then press ENTER.
Notes

In safe mode, Windows 2000 uses only basic files and drivers (mouse, monitor, keyboard, mass storage, base video, default system services, and no network connections). You can choose the Safe Mode with Networking option, which loads all of the above files and drivers plus the essential services and drivers to start networking, or the Safe Mode with Command Prompt option, which is exactly the same as safe mode except that a command prompt is started instead of Windows 2000. You can also choose Last Known Good Configuration, which starts your computer using the registry information that Windows 2000 saved at the last shutdown. 

Safe mode helps you diagnose problems. If a symptom does not reappear when you start in safe mode, you can eliminate the default settings and minimum device drivers as possible causes. If a newly added device or a changed driver is causing problems, you can use safe mode to remove the device or reverse the change. 

There are circumstances where safe mode will not be able to help you, such as when Windows system files required to start the system are corrupted or damaged. In this case, the Emergency Repair Disk (ERD) may help you.
To start Windows 2000 using the last known good configuration 
 1.
Click Options, and then click Print to print these instructions. They will not be available after you shut down your computer in step 2. 
 2.
Click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Please select the operating system to start, press F8. 
 5.
Use the arrow keys to highlight Last Known Good Configuration, and then press ENTER. 

NUM LOCK must be off before the arrow keys on the numeric keypad will function.
 6.
Use the arrow keys to highlight an operating system, and then press ENTER.
Notes

Choosing Last Known Good Configuration provides a way to recover from problems such as a newly added driver that may be incorrect for your hardware. It does not solve problems caused by corrupted or missing drivers or files. 

When you choose Last Known Good Configuration, Windows 2000 restores information in registry key HKLM\System\CurrentControlSet only. Any changes you have made in other registry keys remain. 
To start your computer at a command prompt 
 1.
Click Options, and then click Print to print these instructions. They will not be available after you shut your computer down in step 2. 
 2.
Click Start, and then click Shut Down. 
 3.
Click Restart, and then click OK. 
 4.
When you see the message Please select the operating system to start, press F8. 
 5.
Use the arrow keys to highlight Safe Mode with Command Prompt, and then press ENTER. 

NUM LOCK must be off before the arrow keys on the numeric keypad will function.
 6.
Use the arrow keys to highlight an operating system, and then press ENTER. 
To start the computer and use the Recovery Console
 1.
Insert the Windows 2000 Setup compact disc (CD), or the first floppy disk you created from the CD, in the appropriate drive: 

For systems that cannot start (boot) from the CD drive, you must use a floppy disk. 

For systems that can start (boot) from the CD drive, you can use either the CD or a floppy disk. 
 2.
Restart the computer, and if using floppy disks, respond to the prompts that request each floppy disk in turn. 
 3.
When the text-based part of Setup begins, follow the prompts; choose the repair or recover option by pressing R. 
 4.
When prompted, choose the Recovery Console by pressing C. 
 5.
Follow the instructions on the screen for reinserting one or more of the floppy disks you created for starting the system. 
 6.
If you have a dual-boot or multiple-boot system, choose the Windows 2000 installation that you need to access from the Recovery Console. 
 7.
When prompted, type the Administrator password. 
 8.
At the system prompt, type Recovery Console commands; type help for a list of commands, or help commandname for help on a specific command. 
 9.
To exit the Recovery Console and restart the computer, type exit. 
Important   Because the Recovery Console is quite powerful, it is recommended for use only by advanced users or administrators. 
To use an Emergency Repair Disk for system repairs
 1.
Insert the Windows 2000 Setup compact disc (CD), or the first floppy disk you created from the CD, in the appropriate drive: 

For systems that cannot start (boot) from the CD drive, you must use a floppy disk. 

For systems that can start (boot) from the CD drive, you can use either the CD or a floppy disk. 
 2.
Restart the computer, and if using floppy disks, respond to the prompts that request each floppy disk in turn. 
 3.
When the text-based part of Setup begins, follow the prompts; choose the repair or recover option by pressing R. 
 4.
When prompted, insert the Windows 2000 Setup CD in the appropriate drive. 
 5.
When prompted, choose the emergency repair process by pressing R. 
 6.
When prompted, choose between the following: 

Manual Repair (press M): This should be used only by advanced users or administrators. Use this option to choose whether you want to repair system files, partition-boot sector problems, or startup environment problems. 

Fast Repair (press F): This is the easiest option, and does not require input. This option will attempt to repair problems related to system files, the partition boot sector on your system disk, and your startup environment (if you have a dual-boot or multiple-boot system). 
 7.
Follow the instructions on the screen and, when prompted, insert the Emergency Repair Disk in the appropriate drive. 

During the repair process, missing or corrupted files are replaced with files from the Windows 2000 CD or from the systemroot\Repair folder on the system partition. Replacement files from either of these sources will not reflect any configuration changes made after setup.
 8.
Follow the instructions on the screen; you might want to write down the names of files that are detected as faulty or incorrect, to help you diagnose how the system was damaged. 
 9.
If the repair was successful, allow the process to complete; it will restart the computer. 

The restarting of the computer indicates that replacement files were successfully copied to the hard disk.
Important   Because the emergency repair process is quite powerful, it is recommended for use only by advanced users or administrators. 
Concepts

Disaster recovery overview 

Understanding disaster recovery 

Using disaster recovery options 

Resources 
Disaster recovery overview
A computer disaster is any event that makes a computer unable to start or continue running. The causes of computer disasters range from failure of a piece of hardware to a complete system loss, such as in the case of fire or other similar events. When Windows 2000 encounters such an event, it might report a STOP error, and display the information necessary for you and a Microsoft Product Support Services engineer to locate and identify problem areas.
Disaster recovery is the restoration of a computer so that you can log on and access system resources after a computer disaster has occurred. Windows 2000 provides the following options to help you identify and recover from computer disasters:
Safe mode
You use safe mode startup options to start the system with only the minimal necessary services. Safe mode options, including Last Known Good Configuration, are especially useful if a newly installed device driver is causing problems with starting the system. For more information, see Safe mode startup options.
Recovery Console 
An option to consider if safe mode does not help is the Recovery Console. This option is recommended only for advanced users or administrators. The method for starting the system is to use the Setup compact disc (CD) or floppy disks you created from the CD. Then, you can access the Recovery Console, a command-line interface from which you can perform tasks such as starting and stopping services and accessing the local drive (including drives formatted with the NTFS file system). For more information, see The Recovery Console.
Emergency Repair Disk 
If safe mode and the Recovery Console are not workable in your situation, and if you made appropriate advance preparations, you can try to repair your system with the Emergency Repair Disk. The Emergency Repair Disk can help you repair core system files. 
Understanding disaster recovery
This section covers: 

Safe mode startup options 

The Recovery Console 

Emergency Repair Disk 
Safe mode startup options
If your computer will not start, you may be able to start it in safe mode. In safe mode, Windows 2000 uses default settings (VGA monitor, Microsoft mouse driver, no network connections, and the minimum device drivers required to start Windows).
For example, if your computer will not start after you install new software, you may be able to start it with minimal services in safe mode and then change your computer settings or remove the newly installed software that is causing the problem. You can reinstall the service pack or the entire operating system, if necessary.
If a symptom does not reappear when you start in safe mode, you can eliminate the default settings and minimum device drivers as possible causes.
The safe mode options are:
Safe Mode
Starts Windows 2000 using only basic files and drivers (mouse, except serial mice; monitor; keyboard; mass storage; base video; default system services; and no network connections). If your computer does not start successfully using safe mode, you may need to use the Emergency Repair Disk (ERD) feature to repair your system.
Safe Mode with Networking
Starts Windows 2000 using only basic files and drivers, plus network connections.
Safe Mode with Command Prompt
Starts Windows 2000 using only basic files and drivers. After logging on, the command prompt is displayed instead of the Windows desktop, Start menu, and Taskbar.
Enable Boot Logging
Starts Windows 2000 while logging all the drivers and services that were loaded (or not loaded) by the system to a file. This file is called ntbtlog.txt and it is located in the %windir% directory. Safe Mode, Safe Mode with Networking, and Safe Mode with Command Prompt add to the boot log a list of all the drivers and services that are loaded. The boot log is useful in determining the exact cause of system startup problems.
Enable VGA Mode
Starts Windows 2000 using the basic VGA driver. This mode is useful when you have installed a new driver for your video card that is causing Windows 2000 not to start properly. The basic video driver is always used when you start Windows 2000 in Safe Mode (either Safe Mode, Safe Mode with Networking, or Safe Mode with Command Prompt).
Last Known Good Configuration
Starts Windows 2000 using the registry information that Windows saved at the last shutdown. Use only in cases of incorrect configuration. Last known good configuration does not solve problems caused by corrupted or missing drivers or files. Also, any changes made since the last successful startup will be lost.
Directory Service Restore Mode
Not applicable for Windows 2000 Professional. This is for the Windows 2000 Server operating system and is only used in restoring the SYSVOL directory and the Active Directory directory service on a domain controller.
Debugging Mode
Starts Windows 2000 while sending debug information through a serial cable to another computer.
If you are using, or have used, Remote Install Services to install Windows 2000 on your computer, you may see additional options related to restoring or recovering your system using Remote Install Services.
The Recovery Console
If safe mode and other startup options do not work, you can consider using the Recovery Console; however, this method is recommended only if you are an advanced user or administrator who can use basic commands to identify and locate problem drivers and files. The Recovery Console is a command-line console that you can use after starting the computer with the Setup compact disc (CD)—if the computer's CD drive allows this—or with floppy disks you created from the CD. For information about how to create floppy disks from the Setup CD, see To create boot disks.
To use the Recovery Console, you need to log on to the Administrator account. This console provides commands you can use to do simple operations such as changing to a different directory or viewing a directory, and more powerful operations such as fixing the boot sector. You can access Help for the commands in the Recovery Console by typing help at the Recovery Console command prompt.
Using the Recovery Console, you can start and stop services, read and write data on a local drive (including drives formatted with the NTFS file system), copy data from a floppy disk or CD, format drives, fix the boot sector or master boot record, and perform other administrative tasks. The Recovery Console is particularly useful if you need to repair your system by copying a file from a floppy disk or CD-ROM to your hard drive, or if you need to reconfigure a service that is preventing your computer from starting properly. For example, the Recovery Console could be used to replace an overwritten or corrupted driver file with a good copy from a floppy disk.
Important   Because the Recovery Console is quite powerful, it is recommended for use only by advanced users or administrators. 
Emergency Repair Disk
You can use the Windows 2000 Emergency Repair Disk (ERD) to fix problems preventing you from starting your computer.
By preparing an ERD when your computer is functioning well, you can be prepared to use it if you need to repair system files. (In this situation, to start a computer that needs repair, you use the Windows 2000 Setup compact disc or floppy disks you created from the compact disc.) The repairs possible with this method are limited to basic system files, the partition boot sector, and the startup environment. The repair process does not recover the registry. To replace registry files, use the Recovery Console. The Emergency Repair Disk does not back up data or programs, and is not a replacement for regularly backing up your system.
For more information, see To create an Emergency Repair Disk and To use an Emergency Repair Disk for system repairs.
Using disaster recovery options

Fixing a boot failure 

Tools and techniques 
Fixing a boot failure
If the system or boot volume of a disk fails, the system will not start. The process used to recover from a startup failure depends on the disk configuration.
Before you can start Windows from the mirror of a failed system or boot volume, you need to add an ARC path entry to the Boot.ini file on your boot disks. When the mirror of the boot or system volume is created in Disk Management, the system automatically displays the correct ARC path for the mirrored volume. You can write this path down and use it to correctly modify the boot.ini file. For an explanation of the ARC path, see the Windows 2000 Server Resource Kit.
Boot disks
To make Windows boot disks, see To create boot disks. After you have created the boot disks, you should test them in advance of any failure, or you might not be able to start your computer from the mirrored volume if the primary disk is lost. Check your boot disks by using them to boot the system from the mirrored volume. Test the disk with the primary disk powered on and then with the primary disk powered off. In both cases, if you can log on, the boot disks work.
You should update the boot disk every time volumes are changed. For example, if you are using volume 2 to start and you delete volume 1, you must change the ARC name to start using volume 1. Likewise, if you are starting on volume 2 and you delete volume 1 and split it into volumes 1 and 2, you must change the ARC name to start using volume 3.
Maintaining the boot configuration
After Windows starts successfully, back up the configuration directory (\Systemroot\System32\Config), and maintain current backups as you change the configuration and accounts. The registry is made up of the files in the configuration directory.
If you have to use the Repair process in Windows Setup to restore the registry files, you can restore the configuration from your backup.
Never delete Boot.ini, Ntldr, Bootsect.dos, Ntdetect.com, or Ntbootdd.sys (if Windows is installed on a SCSI disk) in the root directory of the system volume.
If you made changes to a system that previously started Windows successfully and now it does not start, you can return to your previous configuration by selecting Last Known Good Configuration at system startup. If Windows still does not start, use the Repair process in Windows Setup to restart the system. After the system is restarted, you can restore data by using backup tapes.
Repairing Config.nt and Autoexec.nt
If Windows displays an error message concerning these files, or if you have problems running MS-DOS–based programs, check whether Config.nt or Autoexec.nt is incorrect or missing. The files are located in the \Systemroot\System32 directory.
If the files are incorrect or missing, you can copy new versions from the boot disks to the \System32 directory.
Tools and techniques
The following system diagnosis, recovery, and repair options are available with Windows 2000:

Using Windows 2000 System Information to diagnose configuration problems. 

Specifying how Windows 2000 Server records and responds to severe errors, by using the settings under Recovery on the Startup/Shutdown tab of System in Control Panel. 

Restoring the previous working configuration by using the Last Known Good Configuration. 

Using safe mode boot to restore basic system operation. 

Restoring corrupted or missing system files, as well as the boot sector and configuration information by using the Repair process in Windows 2000 Setup. 

Creating and using a boot disk to start the computer after failure of the primary volume. For details, see Fixing a boot failure. 
Windows 2000 System Information
You can use Windows 2000 System Information, the diagnostic tool for Windows 2000, to view and print configuration information for a local or network computer. Windows 2000 System Information is located under System Tools in the Computer Management snap-in available in Administrative Tools.
By using Windows 2000 System Information, you can view the following:

Resource conflicts and sharing 

Operating system information, such as the version number and system boot options, plus process, system, and user environment variables 

Hardware details such as BIOS information, video resolution, CPU type, and CPU steppings 

Physical memory, paging file information, and direct memory access (DMA) usage 

The current state of each driver and service on the computer 

Drives and devices installed on the computer, plus related interrupt (IRQ) and port information 

Network information, including transports, configuration settings, and statistics 

Printer settings, font settings, and system processes that are running 
System failure reporting
When a severe error (called a STOP error) occurs, by default the system does the following:

Writes an event to the system log 

Alerts administrators 

Dumps system memory to a file you can use for debugging 

Automatically restarts the server 
Fatal system errors cause less server downtime because Windows 2000 Server automatically restarts rather than waiting for administrator intervention.
The dump of system memory to a log file can be valuable for debugging the cause of the STOP error. If you contact your technical support representatives about the error, they might ask for the log file. Notice that Windows 2000 writes the log file to the same file name (Memory.dmp, by default) each time a STOP error occurs. To preserve log files, you should copy them to a new file name after the computer restarts. For information about how to configure recovery options, see Choosing recovery actions to occur if Windows 2000 stops unexpectedly.
Last Known Good Configuration
If you encounter difficulty starting Windows after you install a new driver or change a driver configuration, you can start Windows using the Last Known Good Configuration. When you do this, the configuration is as it was before you made the changes that prevented it from starting. All configuration changes that were made since your system was last successfully started are lost. For information about starting Windows 2000 using the Last Known Good Configuration, see Start Windows 2000 using the Last Known Good Configuration.
Safe mode boot
If your computer will not start, you may be able to start it in safe mode. In safe mode, Windows 2000 uses default settings (VGA monitor, Microsoft mouse driver, no network connections, and the minimum device drivers required to start Windows). For information about starting Windows 2000 in safe mode, see To start Windows 2000 in safe mode.
Other error-detection tools
Some other ways in which Windows 2000 Server reports errors and preserves your system configuration and data include the following:

If your system uses the NTFS file system, Windows 2000 Server logs all file transactions, replaces bad clusters automatically, and stores copies of key information for all files on the NTFS volume. 

Services and programs record events, including errors, in the event logs that you can view in Event Viewer. For information about Event Viewer, see Using Event Viewer. 

The Alerter and Messenger services work together to provide warnings on printer, security, and user session problems. These services also provide server shutdown warnings if the system uses the UPS service. For information on uninterruptible power supplies, see Using UPS. 

Performance Logs and Alerts can be configured to create an alert log for monitoring performance and generating network alerts. For information about Performance Logs and Alerts, see Performance Logs and Alerts overview. 

The chkdsk command examines disk space and use for the NTFS and file allocation table (FAT) file systems. If there are errors on the disk, chkdsk alerts you and corrects the errors if the /f switch is used. If files are open when chkdsk is attempting to correct disk errors, you can have chkdsk automatically check the disk and correct errors the next time the computer restarts. For more information about running chkdsk, see Chkdsk. 
Important

Using chkdsk to repair file system errors or bad sectors on very large volumes can render the volume inaccessible for several days. 

You can use Dr. Watson for Windows to detect, diagnose, and log application errors for use by technical support personnel. To run Dr. Watson, type start drwtsn32 at the command prompt. Press F1 for Help on setting up and using Dr. Watson.
Resources

Windows 2000 Server family at Microsoft Windows (http://www.microsoft.com/windows) 

Microsoft TechNet at Microsoft TechNet (http://www.microsoft.com/technet) 

Microsoft TechNet compact disks 

Microsoft support at Microsoft Web site (http://www.microsoft.com/) 

Getting Started for Windows 2000 Server 

Windows 2000 Server Resource Kit 

Windows 2000 Server Registry 

Updated technical information
Troubleshooting
What problem are you having?
My computer stops and displays a long message beginning with the word STOP.
Cause: Windows has encountered an error from which it cannot recover, and to prevent file damage, has stopped operating.
Solution: For general instructions on troubleshooting STOP messages, see Troubleshooting STOP messages: general strategies. For specific instructions on troubleshooting STOP messages, see Troubleshooting specific STOP messages.
See also How often to defragment a volume, and To defragment a volume.
My computer supports starting directly from the CD-ROM drive. However, when I try to start from the Windows 2000 compact disc, nothing happens.
Cause: To start your computer directly from the Windows 2000 compact disc, your computer's BIOS must support the El Torito Bootable CD-ROM (no emulation mode) format. Your BIOS may not support that format.
Solution: Check with your computer manufacturer if you are unsure whether your BIOS has this feature. The BIOS specifies the boot order. The CD-ROM should be listed as the first boot device.
